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Introducere în imprimarea 3D
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Scop și obiective învățare

Scopul modulului: Să ofere cursanților cunoștințele de bază 
necesare pentru a înțelege imprimarea 3D

Număr ore: 4 ore

Rezultatele învățării: • Cunoștințe despre imprimarea 3D și 
terminologia de bază 

• Înțelegerea avantajelor și limitărilor 
imprimării 3D pentru diferite aplicații

• Cunoașterea etapelor procesului de realizare 
a unui obiect folosind imprimarea 3D
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Schema de prezentare

• Fabricația aditivă
• Avantaje și limitări ale imprimării 3D
• Scurt istoric al imprimării 3D 
• Etape în tehnologia de imprimare 3D
• Domenii de aplicare pentru imprimarea 3D 
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Fabricația aditivă
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Imprimarea 3D sau fabricația aditivă este un 
proces de fabricare a obiectelor solide tri-
dimensionale adaugând strat după strat. 
Obiectele fizice sunt produse folosind datele 
unui model digital, un model 3D sau alte 
surse cum ar fi un fișier AMF*. 
Prin utilizarea imprimării 3D se pot crea 
produse având aproape orice formă.
În prezent se folosesc mai multe tehnologii 
și materiale pentru imprimarea 3D. De 
curând, echipamentele pentru imprimare 
3D sunt disponibile atât pentru producția 
industrială cât și pentru utilizatorii casnici.

Fabricația aditivă

Sursă: www.smartfactory.lt

*AMF – Additive Manufacturing File
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Ce este 
imprimarea 3D 
și cum 
funcționează?

Fabricația aditivă

https://www.youtube.com/watch?v=Vx0Z6LplaMU
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Avantaje și limitări ale 
imprimării 3D



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Complexitate si libertate în design

• Imprimarea 3D permite crearea
de structuri și părți complexe,
care nu pot fi produse prin
metode convenționale de
producție.

• Pot fi create ușor geometrii
complexe, asigurând o mare
libertate în design.

• Modele complexe pot fi
imprimate 3D ca o singură piesă,
eliminând necesitatea asamblării
pieselor componente.

Avantajele imprimării 3D

3D printed lamp
Sursă: http://mymodernmet.com/bathsheba-grossman-3d-printed-lamps/
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Personalizare și adaptare
• Imprimarea 3D permite, foarte

ușor, personalizarea, fără costuri
suplimentare.

• Dacă este necesară schimbarea
designului unui obiect, doar
fișierul digital trebuie modificat,
fără a fi nevoie de procese de
producție scumpe sau scule și
dispozitive adiționale.

Avantajele imprimării 3D

OwnPhones – customized earphones
Sursă:  https://www.kickstarter.com/projects/ownphones/ownphones-
the-worlds-first-custom-fit-3d-printed-e
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Nu sunt necesare scule și dispozitive
• Unul din avantajele imprimării 3D față de producția

clasică este faptul că această tehnologie nu necesită,
în general, nici un fel de scule sau dispozitive speciale
pentru fabricarea unui obiect sau a părților acestuia.

• Nu sunt necesare costuri adiționale sau timp
suplimentar pentru a crea un obiect complex față de
a crea unul mai simplu.

Avantajele imprimării 3D
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Viteză mare și costuri reduse
• Unul din avantajele imprimării 3D față de metodele

tradiționale de fabricație este durata mică de timp
necesară pentru realizare a unui produs complex.

• Costurile mici derivă și din economia de timp. De
exemplu, obiecte și părți componente pot fi produse
mai repede și doar atunci când sunt necesare,
reducând asfel costurile cu depozitarea și cu mâna de
lucru.

Avantajele imprimării 3D
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Cale mai rapidă și mai lipsită de riscuri către piață
• Deoarece modelele și părțile componente pot fi

produse într-un timp scurt, imprimarea 3D se
folosește pentru verificarea și dezvoltarea ideilor de
design. Este mai ieftin să produci un prototip 3D
decât să recreezi unul deja existent, dacă este nevoie.

• În consecință, imprimarea 3D este bună pentru cei
care vor să dea viață unei idei de produs, pentru că
lansarea pe piață este mai rapidă și cu riscuri mai
mici.

• Imprimarea 3D poate reduce, de asemenea, riscul
pericolelor asociate cu anumite procedee de
prototipare manuală.

Avantajele imprimării 3D
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Mai puține reziduuri, mai sustenabil și mai prietenos cu mediul
• Imprimarea 3D este un procedeu aditiv – un obiect este creat

din materia primă adăugând strat după strat. Metodele de
fabricație aditivă folosesc doar materialul necesar pentru
producția obiectului respectiv.

• Majoritatea proceselor aditive folosesc materiale ce pot fi
reciclate sau pot fi refolosite de mai multe ori pentru a
imprima 3D obiecte. Prin urmare, fabricația aditivă produce
foarte puține reziduuri.

Avantajele imprimării 3D
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• Costuri ridicate pentru producție de serie mare
• Prețul imprimantelor și al materiei prime este în continuare

ridicat dar există tendința ca acestea să scadă.
• Game reduse de materiale, culori și finisaje
• Există limitări comparativ cu metodele convenționale.

• Rezistență și durabilitate limitate
• Nu toate tehnologiile aditive asigură durabilitatea produselor.

Rezistența nu este uniformă.

• Precizia produselor imprimate 3D
• Anumite procese aditive nu sunt foarte precise

• Majoritatea imprimantelor 3D au limitări legate de
dimensiunile produsului

Limitări în imprimarea 3D
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Provocări în imprimarea 3D

În ciuda limitărilor pe care le avem
astăzi, tehnologiile de imprimare 3D
se dezvoltă foarte rapid și costurile
tind să se reducă. Astfel, tehnologiile
de imprimare 3D devin din ce în ce
mai răspândite.



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Scurt istoric al imprimării 
3D
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În 1983 Chuck Hull, co-fondator al 3D
systems, a inventat primul procedeu
de imprimare 3D numit
‘stereolithography’ (SLA).
Într-un brevet, acesta a definit
stereolitografia ca ‘o metodă și aparat
de fabricare a obiectelor solide prin
“imprimarea” succesivă de straturi
subțiri de material ce se întărește sub
acțiunea razelor ultraviolete, unul
peste altul’.
Prin aceasta a stabilit baza pentru
ceea ce azi cunoaștem a fi fabricația
aditivă – sau imprimarea 3D.

Scurt istoric al imprimării 3D

The SLA-1, the first commercially available 3D printer
Sursă: https://www.3dsystems.com
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Prima imprimantă 
Selective 
Laser Sintering (SLS) 
a fost dezvoltată și 
patentată de Dr. Carl 
Deckard și Dr. Joe 
Beaman la 
Universitatea din 
Texas, în 1986.

Scurt istoric al imprimării 3D

Ziar American , 1987
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Prima piesă imprimată 3D

Sursă: https://www.3dsystems.com/
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În 1989, S. Scott Crump împreună cu soția sa și co- fondatoarea
Stratasys, Lisa Crump, au inventat și patentat tehnologia ‘Fused
Deposition Modeling’ (FDM).
FDM este o marcă înregistrată a Stratasys – prin urmare mulți
profesioniști din industrie au ales să folosească în locul acesteia
termenul Fused Filament Fabrication (FFF).

Scurt istoric al imprimării 3D
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În 2005 au început să expire
brevetele legate de tehnologia
aditivă.
În 2004 a fost lansat proiectul

RepRap la universitatea din Bath
(UK) de către dr. Adrian Bowyer.
Scopul proiectului era să creeze o
imprimantă 3D cu preț redus,
capabilă să se auto-reproducă.
Pe 9 februarie 2008, RepRap 1.0
"Darwin" și-a imprimat cu succes
peste 18% din propriile
componente.

Scurt istoric al imprimării 3D

Sursă: https://all3dp.com/history-of-the-reprap-project/
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Apariția imprimantelor compac-
te, open-source, cu software
gratuit precum RepRap a
permis folosirea tehnologiei de
către un grup mai larg de
utilizatori, în scopuri comerciale
la o scară mai mică, educaționale
și personale. Astfel au apărut
firme de imprimare 3D la costuri
reduse.
Prima imprimantă 3D de birou a
fost creată în cadrul proiectului
RepRap.

Scurt istoric al imprimării 3D

Sursă: www.reprap.org
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Imprimarea 3D a fost limitată doar la utilizare industrială până
în 2009. De atunci vânzările de imprimante 3D au crescut în
continuu.
Se așteaptă multe inovații în domeniu, în anii următori.

Scurt istoric al imprimării 3D
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Carbon3D, una 
dintre cele mai 
rapide 
tehnologii de 
imprimare 3D, 
aflată în curs de 
dezvoltare

Scurt istoric al imprimării 3D

https://www.youtube.com/watch?v=UpH1zhUQY0c
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Scurt istorc al imprimării 3D

https://www.youtube.com/watch?v=OjaW6C61_dc

Chuck Hull / 
Inventatorul 
imprimării 3D
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Etape în tehnologia de 
imprimare 3D
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1. Modelul digital
Primul pas în procesul de fabricație aditivă este realizarea
modelului digital. Pentru aceasta se folosește Computer Aided
Design (CAD).
Există multe programe CAD, care folosesc diferite principii de
modelare, capacități și politici de costuri. De exemplu se pot
folosi Solidworks, Autodesk Fusion 360, SketchUp .
Ingineria inversă se poate utiliza pentru a genera un model
digital, prin scanare 3D.

Etape în imprimarea 3D
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2. Modelul în format STL
În această etapă, un modelul digital este convertit într-un fișier 
STL (stereolithografie) acceptat de către imprimantele 3D.

Se poate selecta un model STL din bazele online existente
precum Pinshape, GrabCAD etc. Unele din aceste baze oferă
modele gratis, altele contra cost.

Etape în imprimare 3D
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Etape în imprimare 3D

3. Verificarea și repararea modelului STL
În această etapă se verifică și repară potențiale erori ale fișierului STL.
Erori tipice: lipsa triunghiurilor, margini neconectate, inversări ale
normalelor (o fațetă este percepută, greșit, ca interior al piesei).
Există software pentru manevrarea modelelor STL cum ar fi Meshlab,
3DPrintCloud, Netfabb etc.
Dacă nu sunt erori, se pot face alte corecții: dimensionare, densitate,
modificări de geometrie.
Se poate stabili, de asemenea, o orientare adecvată a modelului 3D.
Odată ce un fișier STL a fost generat, acesta este importat într-un
program (slicer) care îl convertește în cod G. Codul G este un limbaj de
programare folosit in fabricarea asistată de calculator (CAM) pentru
controlul mașinilor unelte automate.
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4. Pregătirea imprimantei 3D
În această etapă, echipamentul este pregătit pentru imprimare.
Procesul necesită setarea corespunzătoare și controlul
imprimantei 3D, curățarea mesei de lucru și încărcarea materiei
prime. Este necesară și o verificare de rutină a tuturor setărilor
de imprimare principale și a panoului de control.
Când echipamentul este pregătit, se poate încărca fișierul 
pentru imprimare 3D.

Etape în imprimarea 3D
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5. Imprimarea 3D
Procedura de imprimare 3D este, în mare parte, automată. În
funcție de dimensiunea obiectului, de materiale și de
imprimantă, procedura poate dura de la câteva ore până la
câteva zile. Trebuie să se verifice, din când în când, să nu existe
erori.

Etape în imprimarea 3D
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6. Înlăturarea obiectului imprimat
În majoritatea cazurilor, în imprimarea 3D non-industrială,
înlăturarea obiectului imprimat se face cu ușurință – se separă
piesa imprimată de masa de imprimare.

Etape în imprimare 3D
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7. Procesarea ulterioară
Procesarea pieselor după imprimare poate varia destul de mult,
în funcție de tehnologia de imprimare și de materialele folosite.
De exemplu, o piesă imprimată prin SLA trebuie întărită sub raze
UV în timp ce una imprimată prin FDM poate fi manevrată
imediat.
Procesarea produsului final poate include curățare manuală sau
cu aer comprimat, lustruire, colorare și alte acțiuni care
pregătesc produsul pentru utilizarea finală.

Etape în imprimarea 3D



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Domenii de aplicare 
pentru imprimarea 3D
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Imprimarea 3D în 
industria auto se 
folosește atât pentru 
prototipuri cât și pentru 
piese funcționale. 
Multe echipe de 
Formula 1 au folosit 
imprimarea 3D în 
prototiparea, testarea și 
crearea pieselor 
personalizate folosite în 
competiții. 

Industria  auto

Racing car seat
Sursă: www.voxeljet.com
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Industria  auto

Cauciuc imprimat 3D
Sursă: https://futurism.com/videos/meet-the-tire-that-never-needs-air-or-be-
replaced/

Acest cauciuc Michelin nu are 
nevoie de aer pentru că este 
imprimat 3D și nu trebuie 
înlocuit niciodată.
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Unul din cele mai
importante domenii de
aplicare pentru imprimarea
3D este industria medicală.
Prin intermediul imprimării
3D, chirurgii pot produce
părți sau organe imprimate
3D special concepute
pentru nevoile pacienților.
De asemenea, pot folosi
modele imprimate 3D
pentru a planifica operații
și, potențial, să salveze
vieți.

Industria medicală

Primul implant imprimat 3D din polimeri aprobat de FDA
Sursă: http://3dprintingindustry.com/news/the-first-3d-printed-polymer-implant-to-
receive-fda-approval-5821/
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Proteze

Parte a corpului imprimată 3D
Sursă: http://weburbanist.com/2015/01/08/exo-prosthetics-light-cheap-custom-3d-printed-body-parts/
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Proteze

Proteză imprimată 3D
Sursă: http://weburbanist.com/2013/07/18/handicapable-3d-printed-flexible-casts-artificial-limbs/
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Design pentru 
încredere
Creația 
inovativă a lui 
Scott Summit 
demonstrează 
cum 
imprimarea 3D 
și scanarea 
digitală pot fi 
folosite pentru 
a îmbunătăți 
designul 
protezelor.

Proteze

https://www.youtube.com/watch?v=6wnnNk91EMs
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Tehnica dentară

Imprimare 3D în tehnica dentară
Sursă: x3dprinting
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Aeronave

Motoare cu piese imprimate 3D echipează următoarea generație de avioane Airbus
Sursă: http://www.gereports.com/post/119370423770/jet-engines-with-3d-printed-parts-
power-next-gen/

GE Aviation și Safran au 
dezvoltat o metodă pentru 
a imprima  duzele de 
combustibil pentru 
motoarele de avion. 
Tehnologia permite 
inginerilor  să înlocuiască 
structuri complexe cu o 
singura piesă care este mai 
ușoară decât variantele 
anterioare și eficientizează 
utilizarea combustibilului 
cu până la 15%. 
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Tehnologie spațială

Compania SpaceX a lui Elon 
Musk, dedicată realizării de 
vehicole pentru transport în 
spațiu cosmic, a folosit 
imprimarea 3D pentru fabricarea 
motorului SuperDraco ce va fi 
instalat pe nava companiei, 
Dragon. 

Cameră de combustie imprimată 3D, SuperDraco. 
Photo Credit: SpaceX
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În loc să distrugă o mașină clasică 
foarte prețioasă, producătorii 
filmului Skyfall au imprimat o replică 
avand o treime din dimensiunea 
unui Aston Martin DB5 care a fost 
distrusă într-o scenă din film pentru 
efecte speciale.

Divertisment

Piese din plastic ale Aston Martin ©Propshop Modelmakers Ltd

Modelul finalizat Aston Martins ©Propshop Modelmakers Ltd
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Artiștii și designerii folosesc
tehnologia imprimării 3D pentru a
realiza diferite lucrări de artă. Se
deschid astfel noi dimensiuni în
designul creativ ce pot trece
dincolo de limitele tehnologiei
convenționale.

Artă/ Design/ Sculptură

Lampa imprimată 3D
Sursă:  https://www.voxeljet.com/industries/foundries/printed-designer-lamps/
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Artă/ Design/ Sculptură

Scaun imprimat 3D
Sursă: https://www.voxeljet.com/industries/foundries/designer-furniture/
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Artă/ Design/ Sculptură

Sculptura Ivan the Gorilla realizată prin imprimare 3D
Sursă: https://www.voxeljet.com/industries/foundries/3d-printing-helps-to-return-a-silverback-gorilla-back-to-life/
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Imprimarea 3D este des folosită 
în arhitectură. Arhitecții pot crea 
rapid și ușor machete imprimate 
3D din datele CAD folosite 
pentru redactarea planurilor. 
Modelele 3D pot fi imprimate 
din diferite materiale și în culori 
realistice. 

Arhitectură

Sursă: https://www.frendel.com/gallery-image/project-absolute-world/
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Absolute 
Towers din 
Ontario, 
Canada, sunt 
creația 
arhitectului 
Attila Burka

Arhitectură

https://www.youtube.com/watch?v=il5H-9oKBVo
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Bijuterii

Imprimarea 3D poate relansa arta 
creării bijuteriilor de către 
pasionați deoarece nu necesită 
echipamente scumpe de precizie, 
îndemânare sau mulți ani de 
experiență. 

Sursă: CustomMade
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Deși încă nu este o 
variantă economică, 
imprimarea 3D poate 
fi folosită in 
domeniul modei, 
pentru tocuri, bikini 
și poșete ce pot fi 
imprimate mai ușor 
decât pot fi țesute. 

Modă

Sursă: Shapeways
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Primii bikini 
imprimați 3D 
din lume.

Modă

https://www.youtube.com/watch?v=d2iT8S0m3m4
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Prima 
imprimantă 
3D cu 
ciocolată din 
lume.

Industria alimentară

https://www.youtube.com/watch?v=BIFi8but3Vw
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Imprimarea 3D asigură o 
metodă excelentă pentru 
vizualizarea geometriei și 
pentru inițiative în 
design, în școlile de artă. 
De asemenea, se 
folosește în numeroase 
discipline de studiu 
pentru cercetare.

Educație

Kit disecție broască imprimat 3D. 
Sursă: MakerBot Thingiverse
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Cum mai poate fi 
folosită imprimarea 
3D. Exemple.

Alte domenii

Infographics by Jeff Hansen, HoneyPoint3DTM
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Useful Topic Related Links

https://en.wikipedia.org/wiki/3D_printing

https://www.youtube.com/watch?v=Vx0Z6Lpl
aMU
https://youtu.be/Tyc4Apyk2Rc

https://www.ted.com/talks/avi_reichental_wh
at_s_next_in_3d_printing
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Tehnologii disponibile de 
printare 3D
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Scopul şi rezultatele învăţării

Scopul modulului: Să furnizeze studenţilor cunoştinţele de bază
referitoare la principalele procedee de printare 3D, la
avantajele şi limitările acestora, precum şi cunoştinţele
de bază legate de materiale de fabricaţie şi de formatul
STL

Număr de ore: 3h

Rezultatele învăţării: • Dobândirea de cunoştinţe referitoare la principalele
tipuri de procedee de printare 3D, precum şi la
avantajele şi limitările acestora

• Înţelegerea aspectelor de bază legate de
materialele de fabricaţie utilizate în printarea 3D

• Dobândirea de cunoştinţe referitoare la formatul
STL
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Conţinutul cursului

• Tipuri de procedee de printare 3D: 
• Principiu de bază
• Caracteristici principale
• Materiale
• Avantaje şi limitări
• Exemple

• Formatul STL
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Subiectele cursului

Prima parte a cursuluiCea de-a doua parte a 
cursului

Modelare 3D 
CAD

Tipuri de procedee de 
printare 3D

Fişier STL
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Tipuri de procedee de 
printare 3D
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Other….

E.g. Laminated Object 
Manufacturing (LOM):

Raw material:

Paper

Procedeele pot fi clasificate în funcţie de starea materiei prime 
utilizată în fabricaţie
Sunt considerate două tipuri de procedee, având în vedere că
acestea sunt cel mai des utilizate în practică:

Tipuri de procedee de printare 3D

Tehnologia de printare 3D

Fused Deposition 
Modelling (FDM)

Raw material state: 
Polymer filament

Stereo Lithography 
(SL)

Raw material: 
Photosensitive 
Liquid Resin

Selective Laser 
Sintering (SLS)

Raw material:

Powder (including 
polymer, ceramic, 
metal)

Subiectele cursului
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Principiul de bază:
1. Un filament de polimer încălzit peste

punctul său de topire este extrudat
printr-o duză şi depus pe o platformă

2. Acest strat se solidifică, mişcarea
duzei fiind coordonată în funcţie de 
geometria piesei la nivelul acelui
strat

3. Polimerul este extrudat din nou, iar
când intră în contact cu stratul
anterior se solidifică şi aderă la 
acesta formând un nou strat solid

4. Procedura se repetă până când piesa
este fabricată în totalitate

Depunere de filament de material - FDM

Imprimanta 3D FDM Zortrax
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Click pe video 
pentru a 
vedea cum 
funcţionează
procedeul
FDM

Principiul FDM

https://www.youtube.com/watch?v=WHO6G67GJbM
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1. Grosimea stratului (mm): de la 0.127 la 
0.33 (în funcţie de material)

2. Spaţiu de lucru (mm): max.60 x50 x600 
3. Toleranţă: ± 0.254mm
4. Piese fabricate: piese funcţionale, deşi
caracteristicile lor mecanice sunt inferioare
pieselor injectate în matrită, de exemplu

FDM – Caracteristici principale

N.B.: Caracteristicile de mai sus sunt
informative având în vedere că acestea pot
varia de la un printer 3D la altul. Acest lucru
este valabil şi pentru alte tehnologii de
printare 3D.

Spaţiul de lucru al imprimantei
FDM Zortrax

z

x
y
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• Procedeul FDM necesită de obicei
două tipuri de material:
1. Material de fabricaţie care

constituie forma dorită a
geometriei 3D

2. Material suport care este necesar
pentru susţinerea părţilor în
consolă. Structurile suport pot fi
generate automat de programul
software al imprimantei 3D sau
pot fi generate manual.

FDM – Materiale

Materialul suport este necesar
pentru filetul interior

Materialul de fabricaţie
formează geometria dorită
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Material suport poate fi eliminat prin
rupere sau dizolvat într-o soluţie bazată
pe apă şi sodă caustică

FDM – Materiale

Piesă FDM introdusă în soluţia
pentru dizolvarea structurii suport
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• Exemple de materiale utilizate de 
obicei în procedeul FDM:
1. ABS – utilizat pentru prototipuri

funcţionale care necesită o bună
rezistenţă mecanică şi chimică. 
Materialul este disponibil în
diferite culori

2. PC – utilizat pentru prototipuri
funcţionale care necesită o foarte
bună rezistenţă la impact şi o bună
rezistenţă termică la 125ºC

FDM – Materiale

Cartuş de ABS utilizat pentru
fabricaţie în procedeul FDM
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• Avantaje
1. Nu utilizează materiale toxice, pot fi 

utilizate într-un birou
2. Operaţii simple de post-procesare
3. Unele imprimate 3D FDM sunt

foarte ieftine, deci accesibile

FDM – Avantaje & Limitări

• Limitări
1. Precizia piesei este dictată de 

grosimea filamentului
2. Piesele nu sunt rezistente pe

direcţie verticală

Imprimantă 3D FDM Stratasys

Imprimantă 3D FDM Reprap
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• Replici ale unor modele anatomice

FDM – Exemple de piese printate 3D 

• Modelul regiunilor Lituaniei

• Prototipul unei
macarale

(Sursa: Universitatea Politehnica din Bucureşti)

(Sursa: Colegiul Northern Lithuania)

(Sursa: Centrul Formación Somorrostro)
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Principiul de bază:
1. Platforma este iniţial 

poziţionată sub suprafaţa liberă 
a polimerului fotosensibil

2. O rază laser direcţionată 
solidifică polimerul

3. Când stratul iniţial este 
solidificat, platforma coboară şi 
un nou strat este format în mod 
similar

4. Procedura este repetată până 
când piesa este finalizată

Stereolitografia (SL)

Imprimanta 3D SL Formlab2 
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Click pe video 
pentru a 
înţelege
principiul de 
funcţionare al 
SL

Principiul SL

https://www.youtube.com/watch?v=NM55ct5KwiI
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1. Grosime de strat (mm): 0.016 –
0.127

2. Spaţiu de lucru (mm): max. 2100 x 
700 x 800

3. Toleranţă: ± 0.15mm
4. Piesa fabricată: detalii fine, precizie

dimensională şi calitate a 
suprafeţelor foarte bune

SL – Caracteristici principale

Spaţiul de lucru al imprimantei
3D SL Formlab2

x

z

y
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SL – Materiale

• În cazul SL, structura suport 
necesară pentru zonele în consolă 
este formată din acelaşi material ca 
şi materialul pentru piesă 
(materialul de fabricaţie).

• Structurile suport sunt eliminate 
manual.

• Piesele SL sunt de obicei post-
tratate în cuptoare UV.

Materialul de fabricaţie care 
constituie geometria piesei

Structura suport
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• Materialul de fabricaţie utilizat în SL este 
o răşină fotosensibilă, ceea ce înseamnă 
că se solidifică atunci când este expusă 
la radiaţie UV

• Proprietăţile mecanice ale piesei depind 
în principal de tipul de material şi de 
timpul de post-tratare

• Există diferite nume comerciale de răşini 
fotopolimerice utilizate de diverse 
imprimante SL (de exemplu, Accura 25 
pentru imprimantele SL ale firmei 3D 
Systems)

SL – Materiale

Cartuş cu răşină fotopolimerică
pentru imprimanta 3D SL 

Formlabs



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Avantaje
1. SL produce piese precise şi cu o 

calitate foarte bună a suprafeţelor
2. Este disponibilă o gamă variată de 

răşini polimerice fotosensibile, cu 
diferite caracteristici

SL – Avantaje & Limitări

• Limitări
1. Materialul trebuie să fie fotosensibil

şi este mai scump comparativ cu 
materialul pentru FDM

2. Procesul de fabricaţie poate fi lent
Piese fabricate pe imprimanta

3D SL Photocentric
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Proteză a unei mâini şi logo, fabricate 
pe imprimanta 3D SL Formlab2

SL – Exemple de piese SL printate 3D



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Subiectele cursului

• Organizarea cursului
Prima parte a cursuluiCea de-a doua parte a 

cursului

Modelare 3D 
CAD

Tipuri de procedee de 
printare 3D

Fişier STL
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Formatul STL
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• STL este formatul de facto pentru
schimbul de date între sistemele CAD 
şi imprimanta 3D

• STL este acronimul pentru Standard 
Tessellation Language

• Fişierele STL sunt generate prin
teselarea modelelor 3D CAD

• Suprafeţele modelelor solide 3D sunt
aproximate cu faţete triunghiulare

• Există două tipuri de fişiere STL – ASCII 
şi binar (binary). Ultimul format 
produce fişiere de dimensiuni mai mici
decât formatul ASCII

Formatul STL
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• Fiecare triunghi este definit
independent prin 3 vârfuri şi normala
unitate

Formatul STL

X1, Y1, Z1

X2, Y2, Z2

X3, Y3, Z3

Lx, Ly, Lz
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• Două cerinţe importante referitoare la 
fişierul STL sunt îndeplinite în timpul
generării acestuia:

1. Ordinea etichetării vârfului
2. Aplicarea regulii vârf-la-vârf

Formatul STL




3 1

2

Suprafaţă exterioară

1 3

2

Suprafaţă interioară
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• Un model virtual 3D poate fi convertit în format STL printr-un 
software 3D CAD

Formatul STL
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• Un model 3D teselat în format STL poate fi vizualizat într-un 
software gratuit de tip viewer (STL file viewer), de exemplu
Open3D Model Viewer

Formatul STL

Modelul 3D CAD iniţial Model 3D triangularizat vizualizat
în Open3D
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• Un astfel de software permite utilizatorul să realizeze operaţii
de tip micşorare/mărire (zoom in/out), să vizualizeze normala
la fiecare faţetă etc.

Formatul STL

Normala la fiecare
faţetă triunghiulară

afişată în viewer-ul în
Open3D
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Useful Topic Related Links

Ce este triangularizarea? 

Depunerea de filamente de material - FDM

Stereolithografia - SL 

Pregătirea fişierelor STL pentru printare 3D 

Exportul fişierelor STL în Fusion 360
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Echipamente de printare 3D 
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Obiectivul și rezultatele învățării

Obiectivul modulului: Să ofere cursanților o înțelegere de bază a 
diferențelor dintre imprimantele 3D industriale, 
desktop și hobby, precum și a componentelor 
principale ale imprimantei 3D FDM

Număr de ore: 2 ore

Rezultatele învățării: • Înțelegerea diferențelor dintre imprimantele 
3D industriale, desktop și hobby

• Înțelegere a componentelor principale ale 
unei imprimante 3D FDM
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Teme principale

• proiectul RepRap
• procesul Fused Deposition Modelling (FDM)/Fused 

Filament Fabrication Fabrication (FFF) – Modelare prin 
Extrudare Termoplastică

• Echipamente FDM/FFF 
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Proiectul RepRap
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RepRap (Replicating Rapid-prototype) este o
imprimantă 3D capabilă să producă o altă
imprimantă similară.

Proiectul RepRap a fost demarat la
Universitatea din Bath (Anglia) cu scopul de a
elabora o imprimantă 3D ieftină, cu capacități
de autoreplicare.

RepRap folosește o tehnică de fabricație
aditivă denumită Fused Filament Fabrication
(FFF) pentru a aplica materialul în straturi: un
filament de plastic este derulat de pe bobină,
topit și depus pentru a fabrica o piesă.

În urma proiectului RepRap a apărut prima
imprimantă 3D tip desktop.

Mai multe informații pot fi găsite pe
www.reprap.org

Proiectul RepRap

RepRap versiunea1.0 (Darwin)
Sursa: https://all3dp.com/history-of-the-reprap-project/
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Proiectul RepRap
În prezent, sute de colaboratori din întreaga lume contribuie la
proiectul RepRap. Întrucât RepRap este un open design, toate
produsele intelectuale rezultate din proiect sunt disponibile în
baza unei licențe gratuite GNU General Public License.
Cum să construiești o imprimantă 3D RepRap:
• How to build a reprap 3D printer -

RepRapOneDarwin (Generația 1)
• How to build a reprap 3D printer - Huxley (mini-reprap, 

portabilă)
• How to build a reprap 3D printer - Mendel (RepRap Versiunea

II)
• How to build a reprap 3D printer - Prusa (ușor de asamblat)
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Proiectul RepRap

https://www.youtube.com/watch?v=FUB1WgiAFHg

Imprimantă 3D 
RepRap Open 
Source
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Adrian 
asamblând 
prima 
imprimantă
RepRap 
“Darwin”

Proiectul RepRap

https://www.youtube.com/watch?v=Mo5Hp_6uD-E
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Procesul FDM/FFF 
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Tehnologia de prototipare rapidă FDM (din engleză Fused
Deposition Modelling, însemnând Modelarea prin Extrudare
Termoplastică) este, de asemenea, uneori numită “Tehnologia
FFF” (din engleză Fused Filament Fabrication), deoarece “FDM”
este un termen brevetat care poate fi folosit numai de compania
Stratasys Inc.
Proiectul RepRap a introdus termenul “tehnologia FFF” (Fused
Filament Fabrication) astfel încât tehnica să poată fi utilizată fără
încălcarea drepturilor de autor.

Procesul FDM/FFF 
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Principiul de bază
Folosind tehnica de Modelare prin
Extrudare Termoplastică (FDM),
filamentul din material plastic este
încălzit până la punctul de topire și
aplicat prin intermediul unei duze de
extruziune. Materialul topit este
depus pe cordonatele X și Y, strat
după strat, în timp ce masa de lucru
sau capul de extrudare se deplasează
pe direcția Z verticală.
În acest fel, construirea obiectului se
face de jos în sus.
Când este necesar se pot imprima
suporți de susținere, care acționează
ca niște schele, și sunt îndepărtați
după finalizarea imprimării.

Procesul FDM/FFF 

Schemă tehnologie FDM

Masă de
imprimare

Sprafață

Extruder

Duze de 
extrudare

Material
suport

Material 
piesă
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Procesul FDM/FFF

https://www.youtube.com/watch?v=WHO6G67GJbM

Tehnologia 
FDM - Fused 
Deposition 
Modeling
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Echipamente FDM 
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Imprimante 3D hobby

Imprimantele 3D hobby
au prețuri reduse, dar
necesită unele
cunoștințe tehnice și o
anumită îndemânare.
Sunt folosite mai ales
pentru imprimarea de
articole personalizate,
jucării, obiecte
decorative etc.

Sursă: http://www.independent.co.uk/life-style/gadgets-and-tech/features/q-how-hard-can-3d-
printing-really-be-a-quite-hard-8761809.html
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Pentru imprimarea 3D direct pe masa
utilizatorului se folosesc imprimantele FDM tip
desktop. Acestea sunt ușor de utilizat, au software
cu interfață intuitivă și pot produce piese rapid și
într-un mod rentabil. Utilizatorii pot crea singuri
fișierele obiectelor de imprimat 3D sau le pot găsi
în arhiva online și le pot personaliza în funcție de
nevoile lor.

Un grup special de imprimante 3D Desktop sunt
imprimante profesionale. Ele sunt folosite pentru
modelarea conceptelor, producerea prototipurilor
sau chiar a pieselor funcționale. Aceste
imprimante au capabilități mai mari și sunt mai
scumpe decât imprimantele desktop pentru
amatori.

Imprimantele 3D Desktop pot fi utilizate în
întreprinderile mici, în educație etc.

Imprimante 3D FDM Desktop
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Imprimantele industriale 3D sunt utilizate pentru produse complet funcționale de înaltă calitate, pot
printa piese cu volum mare și necesită condiții speciale, precum spații largi de lucru, alimentare
electrică de putere și altele. Imprimantele industriale au dimensiuni mari, uneori trebuiesc montate
direct în hală, au o rezoluție foarte mare și folosesc materiale de calitate, mai ales materiale plastice
industriale care pot avea proprietăți speciale, spre exemplu rezistență mare la impact, rezistență la
substanțe chimice, stabilitate termică. Principalele diferențe dintre imprimantele desktop și cele
industriale sunt legate de costuri și de capacitatea de producție – imprimantele industriale pot realiza
produse de dimensiuni mari dintr-o singură imprimare și pot finaliza o comandă de aceleași dimensiuni
într-un timp mai scurt.

Imprimante 3D industriale

Sursa:  Stratasys
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Imprimante 3D FDM: industriale comparativ cu desktop

Caracteristici Imprimante 3D industriale Imprimante 3D Desktop 

Precizia Standard ± 0.15% ( limita minimă ± 0.2 
mm)

± 1% (limita minimă: ± 1.0 
mm)

Grosime de strat tipică 0.18 - 0.5 mm 0.10 - 0.25 mm

Grosimea minimă de perete 1 mm 0.8 - 1 mm

Dimensiuni maxime ale 
piesei imprimate Mari ( 900 x 600 x 900 mm) Medii ( 200 x 200 x 200 mm) 

Materie primă ABS, PC, ULTEM PLA, ABS, PETG

Material suport Solubil în apă Același ca materialul piesei 
(în mod normal)

Capacitate de producție (pe
imprimantă) Redusă/Medie Redusă

Cost Peste 50000 dolari USA 500 – 5000 dolari USA
Sursa: https://www.3dhubs.com/
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Componentele unei imprimante 3D FDM
Masa de printare
Masa de printare obișnuită
(suprafața pe care se imprimă
obiectele) este o foaie de sticlă
cu un anumit tip de suprafață
deasupra, pentru a îmbunătăți
aderența plasticului.
Majoritatea imprimantelor 3D
au elemente care încălzesc
masa de printare. Acest lucru e
necesar pentru a preveni
deformarea piesei și
desprinderea acesteia de pe
masă în timpul imprimării.
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Componentele unei imprimante 3D FDM
Suprafața mesei de printare
Suprafața mesei de printare ajută plasticul să adere la masă în
timpul printării dar, de asemenea, permite și îndepărtarea cu
ușurință a piesei finalizate. Există mai multe tipuri de
suprafețe de printare. Majoritatea imprimantelor vor avea o
suprafață multifuncțională. Totuși, pentru rezultate optime,
este mai bine să se folosească suprafețe diferite, în funcție de
materialul care trebuie printat.
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Filamentul
La imprimantele FDM este
folosit un filament termoplastic
subțire (plastic care se topește
atunci când este încălzit și se
solidifică la temperatura
camerei).

Componentele unei imprimante 3D FDM
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Extrudorul
Extrudorul este o componentă
esențială a imprimantei 3D. Acesta
este compus din două părți: zona rece
cu motorul, care trage filamentul
înăuntru și-l împinge mai departe, și
zona fierbinte (hot end), în care
filamentul este topit și expulzat.

Componentele unei imprimante 3D FDM
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Mecanica mișcării capului de 
imprimare
Cele mai comune imprimante 3D de pe piață sunt
imprimantele carteziene, denumite după sistemul
de coordonate cartezian. Acestea au un cadru
dreptunghiular în interiorul căruia sunt posibile
orice mișcări de-a lungul uneia dintre cele trei axe
perpendiculare: X, Y sau Z. În mod normal, masa de
imprimare se mișcă în direcția axei Z, în timp ce
extrudorul se poate mișca în 4 direcții de-a lungul
axelor X și Y.

La imprimantele 3D tip Delta, extrudorul este ținut
de 3 brațe într-o configurație triunghiulară (de aici
denumirea de “Delta”). Masa de printare este de
obicei circulară și nu se mișcă. Poziția capului de
imprimare este estimată cu ajutorul trigonometriei.
Imprimantele Delta sunt mai rapide decât cele
carteziene și, datorită designului, pot printa obiecte
cu înălțime relativ mare, dar pot fi mai puțin precise
decât imprimantele carteziene.

Componentele unei imprimante 3D FDM 
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Mecanica mișcării capului de imprimare
Imprimantele 3D de tip Polar folosesc un sistem de coordonate
polare, unde poziția este determinată de un unghi și o lungime, nu
de coordonatele X, Y și Z. Asta înseamnă că masa se rotește în cerc,
în timp ce capul de imprimare se mișcă în sus, în jos, în stânga sau
în dreapta. Imprimantele Polar pot funcționa cu doar două
motoare pas-cu-pas și pot crea obiecte mai mari folosind mai puțin
spațiu.
A patra categorie, care a început să fie utilizată tot mai des, este
printarea 3D cu braț robotic, având ca avantaje mobilitatea,
flexibilitatea în poziționarea capului de printare a procesului de
printare care nu mai este fixat de o placă de printare. Cu toate
acestea, calitatea printărilor nu este la fel de bună precum cea a
imprimantelor carteziene convenționale.

Componentele unei imprimante 3D FDM
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Componentele unei imprimante 3D FDM

Exemplu de imprimantă 3D carteziană
LulzBot Mini 3D Printer

Exemplu de imprimantă 3D Delta
SeeMeCNC Rostock MAX v3 3D Printer 
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Componentele unei imprimante 3D FDM
Motoare pas cu pas
Imprimantele 3D folosesc motoare pas cu pas pentru
controlul precis a poziției. Când sunt alimentate, motoarele
pas cu pas execută o mișcare de rotație în pași incrementali și
nu o mișcare continuă.
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Cadrul
Cadrul susține toate celelalte componente ale imprimantei 3D. 
Poate fi din tablă de oțel, aluminiu sau plastic. Adesea, multe 
din componentele cadrului sunt imprimate 3D.

Componentele unei imprimante 3D FDM
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Componentele unei imprimante 3D FDM
Componentele electrice
• Alimentarea – convertește tensiunea alternativă de la rețea în 

tensiune joasă, continuă, pentru imprimantă.
• Placa de bază – asigură executarea comenzilor primite sub 

forma unui program scris în limbajul de programare G (G-code).
• Driverele motorului pas cu pas – acționează motoarele pas cu 

pas prin alimentarea bobinelor acestora într-o anumită 
secvență, rezultând o mișcare de rotație în pași incrementali. 

• Interfața cu utilizatorul – unele imprimante pot avea un ecran
LCD care să le permită să fie controlate direct, fără a avea
nevoie de un computer.

• Slot pentru carduri SD – unele imprimante au, de asemenea, 
un slot pentru cardul SD prin care se pot încărca fișierele G-
code.
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Useful Topic Related Links

https://en.wikipedia.org/wiki/Fused_filame
nt_fabrication

https://www.youtube.com/watch?v=f4RGU
2jXQiE

https://vimeo.com/5202148
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Aplicații software pentru
modelare 3D CAD
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Scopul modulului: Să ofere o viziune de ansamblu a principiilor 
modelării 3D CAD și cunoștințe de bază despre 
softurile CAD gratuite.

Număr de ore: 2 ore

Rezultate învăţare: • Înțelegerea noțiunilor de bază ale modelării  
3D CAD 

• Dobândirea de cunoștințe despre diferitele 
tipuri de aplicații 3D CAD gratuite

Scopul și rezultatele învățării
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Conținutul cursului

• Ce este tehnologia CAD?

• Modelarea 2D

• Modelarea 3D

• Beneficiile CAD 

• Aplicații 3D CAD gratuite

• Autodesk Fusion 360 – privire de ansamblu 
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Ce este tehnologia CAD?
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Proiectarea asistată de calculator 
(CAD) reprezintă folosirea 
tehnologiei computerizate în 
ajutorul proiectării şi generării 
schițelor bidimensionale (2D) şi a 
modelelor tridimensionale (3D) 
ale unui component sau produs.

Exemplu: o secţiune transversală 
2D care este rotită în jurul unei 
axe pentru a produce un model 
3D.

Ce este technologia CAD?
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• Tehnologia CAD a devenit, 
în prezent, parte integrală și 
esențială a activității de 
proiectare în foarte multe 
sectoare:

• arhitectură

• proiectare de produse

• proiectare de bijuterii

• design interior

• domeniul medical etc.

Ce este tehnologia CAD?
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Legătura dintre 3D CAD şi imprimarea 3D

Modelarea 
3D CAD 

Imprimarea 3D 

Un model 3D CAD este creat, mai întâi, cu ajutorul unui program 
CAD gratis/comercial

Modelul CAD este pregătit pentru imprimarea 3D (de ex. conversie 
în STL, corectarea erorilor, stabilirea grosimii stratului etc.)

Urmează procesul de imprimare 3D  

Prioritatea 
cursului:
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Modelarea 2D 



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

CAD poate fi folosit pentru a 
crea forme 2D, de ex. în planul 
XY, folosind elemente simple de 
desen (de ex. linii, arcuri și 
cercuri)

Formele 2D pot fi modificate 
aplicând comenzi de bază 
precum oglindirea (mirror) etc.

Astfel de forme 2D pot fi folosite 
ca bază pentru generarea de 
modele 3D => modelarea 2D 
este necesară pentru modelarea 
3D. 

Modelarea 2D
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Modelarea 3D
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Există trei tipuri principale de 
modele 3D:

• Structuri rețea 
(wireframe) - făcute din 
noduri și muchii

• Suprafețe - reprezintă 
limita obiectului, nu 
volumul său (cum ar fi 
coaja subțire a unui ou)

• Solide - reprezintă 
volumul obiectului

Modelarea 3D
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Multe geometrii 3D au o secțiune 
transversala 2D obișnuită asupra căreia a 
fost aplicată o operație 3D. 

Cum putem transforma formele 2D în 
entități 3D?  Am văzut deja cum putem 
transforma o simplă linie poligonală 2D 
într-o entitate 3D.

Comenzile de bază pentru modelarea 3D 
(de ex. extrudare, translatare (sweep), 
rotire, loft) care se găsesc în mod 
obișnuit în pachetele CAD comerciale, 
permit crearea unei game largi de 
modele 3D.

Modelarea 3D
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Putem crea și o secțiune 
transversală printr-un model 
CAD 3D pentru a 
ilustra/vizualiza elementele 
ascunse.

Modelarea 3D
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Beneficiile utilizării CAD



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Un model virtual CAD poate fi randat pentru a 
vedea cum va arăta în realitate un obiect 
(produs, clădire etc.).

Beneficiile CAD
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…aceasta va ajuta clienții să vizualizeze mai bine diferitele 
scheme de culoare, configurația camerelor etc.

Beneficiile CAD
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Modelele 
virtuale CAD pot 
fi folosite în 
mod dinamic
pentru a mima, 
de exemplu, 
obiecte fizice în 
funcționare

Beneficiile CAD

https://youtu.be/a2pJfuDeZdo
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Aplicații CAD 3D gratuite
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Sunt disponibile câteva 
pachete software gratuite 
pentru modelare CAD, 
cum ar fi:

• Trimble SketchUp

• TinkerCAD

• Autodesk Fusion 360

Aplicații CAD gratuite
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Permite utilizatorilor să creeze cu ușurință 
modele 3D virtuale cu ajutorul câtorva funcții 
directe, precum Push/Pull (Împinge/Trage) și 
multe altele...

Aplicații CAD gratuite– SketchUp
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Permite utilizatorilor să creeze cu ușurință modele 3D 
virtuale on-line, prin intermediul unui simplu browser

Aplicații CAD gratuite– TinkerCAD
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Permite utilizatorilor să încarce cu ușurință și să partajeze 
modele 3D virtuale și schițe on-line, prin intermediul unui 
browser web.

Aplicații CAD gratuite - Fusion 360
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Autodesk Fusion 360 –
privire de ansamblu
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Se poate vizualiza modelul 
CAD din diferite unghiuri 
folosind instrumentul Orbit.

Fusion 360 – Caracteristici de vizualizare
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Click pe clipul 
din dreapta 
pentru a-l 
accesa

Ce este Autodesk Fusion 360?

https://www.youtube.com/watch?v=h9wpIYhYvh4
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Useful Topic Related Links

Computer-Aided Design 

What is Autodesk FUSION 360? 

Fusion 360 for Beginners Webinar



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Modelarea 3D cu Autodesk 
Fusion 360
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Scop și obiective învățare

Scopul modulului: Să ofere cursanților cunoștințele de bază 
necesare în vederea realizării modelelor pentru 
imprimare 3D, folosind programul CAD 
Autodesk Fusion 360.

Număr ore: 11 ore

Rezultatele învățării: • Cunoștințe despre modelarea 3D a 
obiectelor folosind programul Fusion 360.

• Cunoștințe despre generarea fișierelor STL 
din programul Fusion 360.
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Schema de prezentare

• Prolog
• Noțiuni de bază
• Creare schițe 2D
• Modelare 3D
• Folosire materiale pentru controlul aspectului
• Export modele ca fișiere STL
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Prolog



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Schema de prezentare

Prolog
• Introducere
• Obiective învățare
• Programul cursului
• Ce este Fusion 360?
• Despre acest material de studiu
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Scopul acestui material de studiu Fusion 360 este de a face o
scurtă prezentare generală a posibilităților oferite de software și
de a ajuta participanții să dobândească cunoștințe de bază despre
utilizarea acestuia.
Programul Fusion 360 este un instrument extrem de cuprinzător
și nu e posibilă tratarea detaliată a tuturor caracteristicilor sale,
aici. De asemenea, scopul cursului este doar realizarea de
modele pentru imprimare 3D.
Drept urmare, materialul se axează pe abilitățile fundamentale și
pe conceptele de pregătire, după însușirea cărora participanții își
pot dezvolta abilitățile mai departe, în mod independent.
Acest material trebuie considerat ca un tutorial simplificat Fusion
360, nu ca un substitut al documentației software.

Introducere
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Acest material este format din 6 capitole. Subiectele sunt
conectate logic și este recomandată parcurgerea lor în ordinea
implicită. Pentru a ameliora insușirea materialului de studiu,
unele subiecte importante sunt însoțite de exerciții practice.
Tot materialul care urmează este pregătit pe baza unui produs
real (un organizator birou) proiectat pentru imprimare 3D.
În cadrul cursului veți învăța despre instrumente și tehnici ale
Fusion 360 utile în realizarea modelelor pentru imprimarea 3D,
parcurgând pas-cu-pas etapele modelării organizatorului.

Obiective de învățare



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Organizator birou imprimabil 3D

Produsul de modelat
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Schema de prezentare a cursului
Noțiuni de bază
• Descărcare și lansare software
• Interfața Fusion 360
• Setări de bază
• Import și deschidere fișiere
• Introducerea comenzilor
• Instrumente de navigare și selectare

Creare schițe 2D
• Planificare schițe
• Creare schițe 2D
• Constrângere și dimensionare schițe

Modelare 3D
• Instrumente modelare 3D 
• Creare modele 3D
• Editare caracteristici

Folosire materiale pentru
controlul aspectului
• Aplicare și editare

materiale
• Modificare aspect

Export modele ca fișiere
STL
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Ce este Fusion 360? 

Fusion 360 este un instrument complex dedicat dezvoltării de produse,
bazat pe cloud, ce include software CAD, CAM și CAE, creat de Autodesk
Corporation.
Fusion 360 are numeroase caracteristici:
• sculptare și modelare freeform
• modelare solidă/parametrică/mesh
• simulare și testare
• conversie date
• modelare ansamble
• prelucrări mecanice (machining)
• Imprimare 3D și multe altele
Este o alegere excelentă pentru crearea modelelor pentru imprimare 3D.
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Despre acest material de studiu

Deoarece printscreen-urile și secvențele meniului utilizate în 
acest curs sunt luate de pe un computer cu versiunea din iunie 
2017 a Fusion 360, alte versiuni ale Fusion 360 pot prezenta 
diferențe față de acest material, atât în ceea ce privește 
printscreen-urile cât și secvențele meniului.
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Noțiuni de bază
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Schema de prezentare

Noțiuni de bază
• Descărcare și lansare software
• Interfața Fusion 360
• Setări de bază
• Import și deschidere fișiere
• Introducerea comenzilor
• Instrumente de navigare și selectare
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Obiectivele de învățare ale capitolului

În acest capitol veți învăța noțiunile de bază ale Fusion 360. 
După parcurgerea capitolului veți ști cum să:

• Descărcați și să lansați programul Fusion 360
• Utilizați interfața Fusion 360 pentru setările de bază
• Deschideți și importați fișierele Fusion 360
• Introduceți comenzi
• Utilizați instrumente de navigare și selecție
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Pentru descărcarea și utilizarea Fusion 360 aveți nevoie de un 
cont Autodesk ID. Dacă sunteți student sau profesor/ trainer/ etc. 
puteți obține Autodesk ID și programul Fusion 360 pe
www.autodesk.com/education/free-software/fusion-360

Descărcare Fusion 360
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Dacă sunteți un entuziast sau aveți un hobby pentru care doriți 
să folosiți Fusion 360, puteți obține contul Autodesk ID și 
programul pe www.autodesk.com/products/fusion-360/free-
trial

Descărcare Fusion 360
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Fișierele proiectului pe care îl creați în Fusion 360 sunt
salvate pe platforma din cloud Autodesk 360 (A360), într-un
director dedicat proiectului. Astfel, vă puteți accesa fișierele
din orice browser sau orice computer care are instalat
Fusion 360 autentificându-vă cu propriul Autodesk ID.
• Lansați Fusion 360
• Dacă vi se cere, autentificați-vă cu ID-ul Autodesk.

Start Fusion 360
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Interfața Fusion 360
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• Application bar - Accesare Data Panel, operații cu fișiere,
salvare, undo și redo

• Profile and help – controlează setările de profil și cont; help 
and training

• Toolbar – selecție workspace și instrumente
• ViewCube - orbitare model sau vedere din poziții standard
• Browser – listează obiectele din proiect. Poate fi utilizat 

pentru modificarea obiectelor și controlul vizibilității acestora

Interfața Fusion 360
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• Canvas și marking menu – Click stânga pentru a selecta 
obiecte în fereastra de grafică. Click dreapta pentru a accesa 
meniul marking (conține comenzi utilizate frecvent în partea 
superioară și toate comenzile în meniul cascadă).

• Timeline – listează operațiile efectuate în proiect. Click 
dreapta pe operațiuni pentru a face modificări. Trageți (drag) 
operațiunile pentru a schimba ordinea în care sunt procesate.

• Navigation bar și display settings - Bara de navigare conține 
comenzile folosite pentru zoom, mutare vedere și rotire 
model. Setările display-ului controlează aspectul interfeței și 
modul în care modelele sunt afișate pe ecran.

Interfața Fusion 360
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În meniul cascadă User Profile, aflat în colțul de sus dreapta, faceți 
click pe “Preferences”. Aici se pot seta preferințele referitoare la 
interfața cu utilizatorul, unități de măsură vizibilitate, material, 
grafică etc.

Setări de bază
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Fusion 360 are 7 workspace-uri diferite. Fiecare afișează o bară cu 
instrumente relevante pentru acel workspace specific.Pentru a
selecta un workspace - click Model.

Selectare workspace
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Model: creare și editare geometrie solidă
Patch: creare și editare geometrie suprafețe 
Render: generare rendering-uri realiste ale modelului
Animation: creare animații ale modului în care modelul 
ar trebui să funcționeze
Simulation: realizare analiză stare tensiuni
CAM: generare programe de mașinare pentru fabricarea 
modelului
Drawing: creare desene 2D drawings ale modelului

Workspace-uri disponibile
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Bara setărilor pentru display se află în partea de jos a monitorului 
și controlează aspectul interfeței și modul în care modelele sunt 
afișate. 

Setări display
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Import și deschidere fișiere

În această secțiune veți învăța cum să importați și să deschideți
fișierele.

După parcurgerea secțiunii, veți ști cum să:
• Importați fișiere folosind Cloud Translators
• Importați fișiere folosind Local Translators
• Inserați fișiere și componente
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Import și deschidere fișiere
Există câteva moduri în care se poate deschide, importa sau
transla un fișier în Fusion 360. Importarea unui fișier înseamnă
încărcarea acestuia în cloud. Odată importat, fișierul poate fi
deschis în Fusion 360 din Data Panel.
Dacă Data Panel nu este vizibil in fereastra Fusion 360, faceți
click pe pictograma marcată cu roșu mai jos.
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Importul unui fișier în Fusion 360 se face folosind comanda
Upload (trebuie să fiți în interiorul unui proiect). Pot fi importate
câteva tipuri de fișiere, inclusiv IGES, OBJ, STEP, STL.

Import fișiere cu Cloud Translators
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Folosiți comanda "New Design from File" pentru a importa fișiere
Autodesk Fusion 360 Archive, IGES, SAT/SMT și STEP.

Import fișiere cu Local Translators
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Folosiți diversele comenzi Insert pentru a importa componente și
fișiere (OBJ, STL, DXF and SVG).

Inserare fișiere și componente
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Introducerea comenzilor

Fluxul de lucru din Fusion 360 este creat pentru a se adapta la
preferințele utilizatorului. Comenzile pot fi introduse folosind:
• Pictogramele comenzilor din Toolbar
• click dreapta pe obiectele listate în Browser
• click dreapta pe suprafața de lucru
• Comenzi rapide tastatură
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Instrumente de navigare

Sunt disponibile mai multe căi de manipulare a modului de 
afișare al modelului:
• Navigation Bar
• ViewCube
• Navigare folosind mouse-ul
• Gesturi de atingere pentru touchpad sau dispositive cu touch 

screen
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Comenzi de navigare

Comenzile de navigare se lanseză dând click pe un buton din 
bara de navigare (Navigation Bar).

Orbit - comenzi care rotesc
vederea curentă.
Look At - arată fețele unui 
model într-un plan selectat.
Pan - mută vederea paralel cu 
ecranul.
Zoom - crește sau diminuează 
mărirea vederii curente.
Fit - poziționează întreg 
modelul pe ecran.
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ViewCube

• ViewCube se utilizează pentru a roti camera
• Trageți ViewCube pentru a roti liber modelul
• Dați click pe fețele și colțurile cubului pentru a accesa vederi

ortogonale și izometrice standard.
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Mouse

Folosiți comenzile rapide mouse pentru a mări/micșora,
deplasa și roti vederea. Setați controlul implicit al mouse-ului în
Preferences pentru a schimba modul în care acționează acesta.
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Există mai multe moduri de a selecta obiectele în Fusion 360.

Instrumente de selecție

Butonul de deasupra meniului cascadă arată care mod de 
selecție este activ.
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• Window Selection Trageți cursorul, 
delimitând un dreptunghi, pentru a 
selecta obiecte.

Moduri de selecție

• Freeform Form Selection Trageți 
cursorul, delimitând un lasou, 
pentru a selecta obiecte.

• Paint Selection Trageți cursorul, 
pentru a selecta obiectele atinse 
de acesta.
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Se pot folosi mai multe instrumente și filtre:

Instrumente și filtre de selecție

• Select by Name - selecție obiecte după nume
• Select by Boundary - selecție obiecte aflate între granițele 

unei forme definite de utilizator
• Select by Size - selecție obiecte după dimensiune
• Invert Selection – inversare selecție activă
• Selection Priority – pentru a specifica ierarhia obiectelor 

selectate în fereastra grafică
• Selection Filters – controlează ce tipuri de obiecte sunt 

disponibile pentru selecție.
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Creare schițe 2D
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Schema de prezentare

Creare schițe 2D
• Crearea unei schițe 2D
• Crearea geometriei unei schițe
• Utilizare constrângeri pentru poziționarea geometriei
• Utilizare cote pentru dimensionarea geometriei
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Obiectivele de învățare ale capitolului

În acest capitol veți învăța cum să creați schițe și cum să le 
dimensionați și să le aplicați constrângeri geometrice. 
După parcurgerea capitolului veți ști:
• pașii de bază pentru crearea unei schițe
• cum să creați, constrângeți și dimensionați o schiță
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O schiță este un obiect ce conține geometria necesară definirii 
profilelor. Schițele trebuie create pe planele de origine, pe plane 
de construcție sau pe fețe plane ale modelului.

Crearea unei schițe 2D

Primul pas este începerea 
unui nou proiect (design) 
unde va fi creată geometria:
• Lansați Fusion 360
• Începeți un design nou
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Selectați Sketch > Create Sketch

Crearea unei schițe noi
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Selectați Sketch > Create 
Sketch
Selectați planul “Top” (XZ)

Crearea unei schițe noi
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Geometria schiței poate fi creată și editată folosind 
numeroasele comenzi disponibile. În continuare, 
vom desena un profil folosind comanda Line. 

Crearea geometriei înt-o schiță
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Schițarea unui profil
• Selectați Sketch > Line
• Desenați conturul din imagine dând click în ordinea indicată.
• Conectați ultima linie cu punctul 1 pentru a obține o curbă închisă.

Dacă s-a lucrat corect, interiorul conturului își schimbă culoarea.
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Constrângere profil

• Din Sketch Palette> 
Constraints selectați
Horizontal/Vertical 

• Aplicați constrângerea
Horizontal/Vertical pe toate 
liniile, cu excepția liniei 1
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Constrângere profil

• Din Sketch Palette> Constraints selectați Collinear
• Selectați liniile 2 și 3
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Constrângere profil

• Din Sketch Palette> Constraints selectați Coincident
• Selectați punctul 4 și apoi, din Browser, selectați originea

sistemului de coordonate
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Dimensionarea profilului

• Selectați Sketch > Sketch Dimension
• Plasați cotele pe linii, conform imaginii
• Selectați Stop Sketch
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Modelare 3D
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Schema de prezentare

Modelare 3D 
• Instrumente de modelare 3D
• Creare modele 3D
• Editare caracteristici existente
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Obiectivele de învățare ale capitolului

În acest capitol veți învăța cum să transformați o schiță într-
un model 3D parametric și cum să creați corpuri solide
folosind forme primitive.
După parcurgerea secțiunii, veți ști:
• Să folosiți principalele instrumente pentru crearea

modelelor 3D
• Cum să editați caracteristicile existente
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Instrumente de modelare 3D

Există numeroase instrumente de
modelare în Fusion 360. În acest
curs vom studia doar modelarea
parametrică solidă și crearea
modelelor solide din forme
primitive.
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Crearea unui corp folosind Extrude

• Selectați profilul –
dați click în interiorul 
acestuia

• Click Create> 
Extrude

Comanda Extrude creează un solid 3D prin extinderea conturului 
unui obiect 2D pe direcția perpendiculară, în spațiul 3D.
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Crearea unui corp folosind Extrude

Setați opțiunile comenzii Extrude conform imaginii.
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Decupare corp folosind Press Pull

Press Pull este o comandă care permite accesarea rapidă a 
comenzilor Extrude, Fillet sau Offset Face în funcție de tipul 
geometriei selectate inițial.
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Decupare corp folosind Press Pull

Schițare profil decupare
• Selectați Sketch > Create Sketch
• Selectați vederea LEFT
• Selectați Sketch > Rectangle> 2-Point

Rectangle
• Click în pct. 1 pentru a începe dreptunghiul
• Mutați cursorul pe linia 2 și plasați-l în colțul 

opus al dreptunghiului
• Click pentru finalizarea comenzii
• Selectați Sketch > Sketch Dimension
• Plasați cota 25 mm 
• Selectați Stop Sketch
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Decupare corp folosind Press Pull
Plasare decupaj
• Selectați profilul – click în interiorul dreptunghiului
• Click-dreapta și selectați Press Pull
• Setați opțiunile comenzii Extrude conform imaginii
• Click OK
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Creare corp folosind Cylinder
Comanda Cylinder creează un corp adăugând înălțime unei regiuni 
circulare.
• Click Create > Cylinder
• Selectați suprafața inferioară a obiectului
• Selectați colțul 1 pentru a plasa centrul cilindrului
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Creare corp folosind Cylinder
•Mutați cursorul pînă la 50 mm. Click pentru confirmare dimensiune.
•Trageți săgeata pentru a seta înălțimea cilindrului la 120 mm
•Selectați Join la rubrica Operation
•Click OK
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Creare corp folosind Cylinder
• Click Create > Cylinder
• Selectați suprafața superioară a cilindrului creat anterior
• Selectați centrul suprafeței superioare pentru a plasa centrul 

cilindrului
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Decupare corp folosind Cylinder
•Mutați cursorul pînă la 44 mm. Click pt. confirmare dimensiune
•Trageți săgeata pentru a seta adâncimea cilindrului la 115 mm
•Selectați Cut la rubrica Operation
•Click OK
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Creare corp folosind Box
Comanda Box creează un corp paralelipipedic.
• Click Create > Box
• Selectați suprafața inferioară a obiectului
• Selectați colțul 1 pentru a plasa colțul paralelipipedului
• Mutați cursorul pentru a plasa colțul opus al paralelipipedului 

(punctul 2)



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Creare corp folosind Box

• Setați opțiunile 
comenzii Box 
conform imaginii.

• Click OK
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Combinare corpuri
• Click Modify > 

Combine
• Selectați Box în 

rubrica Target Body
• Selectați Body 1  în 

rubrica Tool Body
• Selectați Cut la 

rubrica Operation
• Selectați Keep Tools
• Click OK pentru 

finalizarea comenzii
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Eliminare corp suplimentar
Un corp nou a fost creat și trebuie eliminat – dați click dreapta pe 
corpul care nu mai este necesar, în Browser, și selectați Remove.
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Unire corpuri

• Click Modify > 
Combine

• Selectați primul corp în 
rubrica Target Body

• Selectați al doilea corp
în rubrica Tool Body

• Setați Join în rubrica 
Operation 

• De-selectați Keep Tools
• Click OK pentru 

finalizarea comenzii

Avem 2 corpuri acum și le vom uni pentru a obține un singur corp.
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Modificare paralelipiped cu Shell

• Click Modify > Shell
• Selectați suprafața 

superioară a 
paralelipipedului

• Setați Inside 
Thickness la 3 mm

• Selectați Inside la 
rubrica Direction

• Click OK pentru 
finalizarea comenzii
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Rotunjire muchii
• Cu tasta Shift apăsată, selectați muchiile albastre din imagine
• Click-dreapta și selectați Fillet
• Setați Radius la 10 mm



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Teșire muchii
• Cu tasta Shift apăsată, selectați muchiile albastre din imagine
• Click-dreapta și selectați Chamfer
• Setați Distance la 5 mm
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Folosire materiale pentru
controlul aspectului
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Schema de prezentare

Folosire materiale pentru controlul aspectului
• Aplicare și editare materiale
• Modificare aspect
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Obiectivele de învățare ale capitolului

În acest capitol veți învăța cum să utilizați materialele fizice și 
materialele vizuale.
După parcurgerea secțiunii, veți ști:
• să aplicați și să editați materiale
• să modificați aspectul obiectelor modelate
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Aplicare și editare materiale

Există 2 tipuri de materiale în 
Fusion360:
• Materiale fizice -

controlează aspectul și 
caracteristicile inginerești 
ale unui component.

• Materiale vizuale –
modifică doar aspectul 
obiectelor. 
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Aplicare materiale fizice

• Click Modify > Physical 
Material

• În caseta de dialog Physical 
Material, deschideți 
directorul Plastic

• Trageți ABS Plastic peste 
model. Materialul și culoarea
modelului se modifică.

• Click Close în caseta de dialog
Physical Material
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Modificare aspect

• Click-dreapta pe model. Click Appearance
• Deschideți fișierul Paint > Glossy în caseta de dialog Appearance
• Selectați din listă Paint – Enamel Glossy (Red)
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Modificare aspect

• Trageți Paint – Enamel Glossy 
(Red) peste model. Culoarea 
materialului se modifică. 
Observați că materialul fizic 
rămâne tot ABS.

• Click Close în caseta de dialog
Physical Material
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Export modele ca fișiere STL
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Obiectivele de învățare ale capitolului

În acest capitol veți învăța cum să exportați modelele 3D ca 
fișiere STL.
După parcurgerea secțiunii, veți putea să exportați modelele 
3D ca fișiere STL.
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Fișierele STL

STL (STereoLithography) este un fișier folosit în imprimarea 3D
și conține modelul 3D de imprimat. STL reprezintă un model 3D
cu ajutorul fațetelor triunghiulare.
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Exportare model ca fișier STL

 În Browser, faceți click-dreapta 
pe Body1 și selectați Save as STL

 În caseta de dialog Save as STL 
selectați Refinement - Medium

 Click OK
 Selectați directorul în care doriți 

să salvați fișierul STL 
 Click Save
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Useful Topic Related Links

https://www.autodesk.com/products/fusion-360/overview

http://help.autodesk.com/view/fusion360/ENU/
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Selectarea unui model STL 
utilizând resurse online
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Scopul şi rezultatele învăţării

Scopul modulului: Să furnizeze cursanţilor cunoştinţele de bază
legate de utilizarea resurselor online conţinând
modele STL, în scopul căutării şi descărcării de
modele destinate printării 3D

Număr de ore: 3h

Rezultate învăţare: • Cunoştinţe teoretice şi practice despre
modalităţile de accesare a fişierelor STL din
arhive online/magazine online/motoare de
căutare în scopul căutării şi descărcării
modelelor dorite
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Conţinutul cursului

• Accesarea modelelor STL utilizând resurse online
(arhive online/magazine online/motoare de căutare)
cum ar fi: Thingiverse, GrabCAD, Pinshape, Yeggi, etc.:
• Căutarea în resursele online, descărcarea de modele STL
• Exemple ilustrative
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Accesarea modelelor STL 
utilizând resurse online
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• Modele STL pot fi descărcate, gratuit sau contra cost, din
mai multe arhive online, magazine online sau utilizând
motoare de căutare. Exemple în acest sens sunt:
Thingiverse, GrabCAD, SketchFab, Pinshape, Yeggi, Autodesk
123d, Pinshape, CGtrader, etc.

• Acestea oferă fişiere STL (în formate Binary sau ASCII), de
obicei grupate pe categorii pentru a facilita căutarea şi
selecţia, precum şi modele 3D în formate neutre sau native
3D CAD care pot fi transformate în modele STL şi apoi
utilizate pentru printarea 3D.

Accesarea fişierelor STL din arhive online
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• De asemenea, fişiere STL pot fi încărcate în aceste arhive
sau magazine online pentru a partaja idei sau obiecte
creative şi utile.

• Unele dintre aceste arhive online sunt deţinute de
producători de sisteme de printare 3D:

• Exemple: Thingiverse de Makerbot, YouMagine de
Ultimaker, Zortrax Library de Zortrax sau GrabCAD de
Stratasys.

Accesarea fişierelor STL din arhive online
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• Detalii referitoare la cele mai importante resurse de fişiere STL

Nume Website Tip Gratuit/Contra cost

Thingiverse www.thingiverse.com Arhiva online Gratuit 

GrabCAD www.grabcad.com Arhiva online Gratuit 

SetkchFab https://sketchfab.com/tags/repository Arhiva online Gratuit 

Yeggi www.yeggi.com Motor de căutare Gratuit, contra cost

Autodesk123d http://www.123dapp.com/Gallery/content/all Arhiva online Gratuit 

STL Finder www.stlfinder.com Motor de căutare Gratuit, contra cost

Pinshape https://pinshape.com/ Magazin online Gratuit, contra cost

CGTrader https://www.cgtrader.com Magazin online Gratuit, contra cost

Yobi3D https://www.yobi3d.com/ Motor de căutare Gratuit 

Zortrax Library http://library.zortrax.com/ Arhiva online Gratuit 

YouMagine https://www.youmagine.com Arhiva online Gratuit 

Accesarea fişierelor STL din arhive online
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• Fluxul de lucru pentru printarea 3D a unui model STL
descărcat dintr-o arhivă sau magazin online sau utilizând un
motor de căutare:

Accesarea fişierelor STL din arhive online
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• Thingiverse – arhivă pentru milioane de modele STL

Exemple – Thingiverse



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Pasul 1: Căutaţi în baza de date termenul (de exemplu):
“catapult”, obţinând afişarea modelelor asociate acestui
cuvânt.

Exemple – Thingiverse
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• Pasul 2: Selectaţi unul dintre modelele de catapultă (nr. 1763518),
fiind afişate diferite modele 3D CAD de catapulte, un film şi imagini
de catapulte printate 3D în materiale de diferite culori.

Exemple – Thingiverse
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• Pasul 3: În meniul Made accesaţi informaţii şi comentarii
despre variantele printate 3D de alţi utilizatori.

Exemple – Thingiverse
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• Pasul 4: Accesaţi informaţii (Summary) cu recomandări legate de
parametri de proces din printarea 3D: material, grosime strat sau
rezoluţie, diametrul duzei, orientare sau suport.

Exemple – Thingiverse
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• GrabCAD – arhivă online pentru modele 3D CAD şi modele 
STL

• Necesită crearea unui cont de utilizator

Exemple – GrabCAD
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• Căutarea prin arhiva GrabCAD utilizând categorii.

Exemple – GrabCAD
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• Pasul 1: Căutaţi cuvântul “bracket” pe GrabCAD, obţinând
rezultatele din figura de mai jos. Pentru fiecare model este
specificat formatul în care poate fi găsit obiectul (format neutru
sau format 3D CAD nativ).

Exemple – GrabCAD



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Pasul 2: Selectaţi şi descărcaţi un model de suport în format
STL.

Exemple – GrabCAD



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Pasul 3: Accesaţi informaţii despre model sau despre
recomandările referitoare la parametri pentru printarea 3D.

Exemple – GrabCAD
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• Pasul 1: Accesaţi site-ul Pinshape şi căutaţi un model: “3D 
watch” (ceas 3D) – de exemplu.

Exemple – Pinshape
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• Pasul 2: Accesaţi informaţii despre cum să se printeze 3D
componentele ceasului şi apoi să se asambleze. Acestea
sunt prezentate ca text şi/sau utilizând filme.

Exemple – Pinshape
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• Pasul 3: Descarcaţi şi extrageţi din arhiva winrar fiecare
componentă a ceasului 3D.

Exemple – Pinshape
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• Motorul de căutare Yeggi reuneşte modele STL (peste 60000) 
din diferite arhive online.

Exemple – Yeggi
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• Pasul 1: Căutaţi în baza de date un cuvânt cheie, de exemplu : 
“spinner”. În funcţie de modelul selectat, platforma 
redirecţionează utilizatorul către o anumită arhivă (Minifactory, 
de exemplu).

Exemple – Yeggi
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• Pasul 2: În funcţie de modelul selectat, platforma
redirecţionează utilizatorul către o arhivă (Minifactory, de
exemplu) de unde poate descărcat.

Exemple – Yeggi
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• STL Finder este un motor de căutare pentru modele STL.
• Căutarea poate fi realizată prin cuvinte cheie sau categorii.
• Utilizaţi filtre - Filters pentru a stabili arhivele în care se face

căutarea.

Exemple – STL Finder
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• Pasul 1: Căutaţi un model prin cuvinte cheie: “mobile support”.
• Pasul 2: Selectaţi un model şi descărcaţi-l din arhiva online în 

care acesta se găseşte.

Exemple – STL Finder
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• Librăria Zortrax necesită crearea unui cont de utilizator.
• Modelele din librăria Zortrax sunt grupate pe categorii,

alegerile editorilor fiind disponibile pe prima pagină.

Exemple – Zortrax Library
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• Informaţii despre numărul de vizualizări, comentarii şi
numărul de descărcări sunt prezentate pentru fiecare
model.

Exemple – Zortrax Library
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• Căutaţi cuvântul cheie: “cube”   –> Selectaţi modelul “Folding
Cube”–> Apăsaţi butonul Download project.

Exemple – Zortrax Library
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• Platforma CGTrade permite selectarea de modele gratuite sau
contra cost, în diferite formate.

• Pentru descărcarea unui model este necesar un cont de
utilizator.

Exemple – CGTrade
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• Pasul 1: Creaţi un cont de utilizator
• Pasul 2: Căutaţi şi descărcaţi, de exemplu, obiectul “pencil

box” în format STL.

Exemple – CGTrade
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Analiza şi corectarea modelelor
3D utilizând aplicaţii software 

dedicate
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Scopul şi rezultatele învăţării

Scopul modulului: Să ofere informaţii despre utilizarea software-
urilor dedicate pentru verificarea şi corectarea
modelelor STL

Număr de ore: 3h

Rezultate învăţare: • Dobândirea de cunoştinţe despre soluţiile
software Netfabb, MeshLab, MiniMagics

• Dobândirea de cunoştinţe despre opţiunile
(comenzile) şi instrumentele automate de
verificare şi corectare a modelelor STL

• Dobândirea de cunoştinţe despre opţiunile
(comenzile) şi instrumentele manuale de
corectare a modelelor STL
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Conţinutul cursului

• Analiza şi repararea modelelor STL 
• Soluţii software pentru analiza şi repararea modelelor 

STL:
• Exemple: Netfabb, MeshLab, Materialise 3DPrint Cloud
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Analiza şi corectarea 
modelelor STL
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Principalele tipuri de erori 
care apar în modelele STL 
sunt:
• Lipsă triunghiuri
• Normale inversate
• Muchii neconectate

Analiza şi corectarea modelelor STL
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• Analiza şi, dacă este necesar, corectarea modelelor STL sunt
paşi obligatoriu de parcurs înainte de a trimite modelul către
aplicaţia software a imprimantei 3D

• Soluţii software dedicate sunt utilizate pentru verificarea şi
corectarea modelelor STL înainte de printarea 3D

• Corectarea modelelor STL poate fi realizată automat sau
manual

Analiza şi corectarea modelelor STL
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Soluţii software pentru analiza 
şi corectarea modelelor STL
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• Netfabb software, www.netfabb.com

• Opţiuni disponibile în versiunea gratuită a Netfabb:
• Instrumente pentru corectarea manuală sau automată a 

modelelor STL
• Instrumente pentru măsurarea grosimii pereţilor
• Instrumente pentru tăierea (secţionarea) modelelor STL

• Opţiunile de corectare (reparare) automată a modelelor STL
rezolvă majoritatea problemelor care apar (goluri, normale
inversate, muchii neconectate).

Software pentru STL - Netfabb
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• Formate de fişiere de import şi export în Netfabb

Software pentru STL - Netfabb
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• Deschiderea unui fişiere STL existent:
• Project→ Open (sau Ctrl+O)
• Project → Add part
• Tragerea (drag-and-drop) modelului STL în aplicaţie

Software pentru STL - Netfabb
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• Un obiect sub formă de mână, care poate fi utilizat ca suport
de telefon mobil, este utilizat pentru exemplificarea opţiunilor
automate de analiză şi corectare a modelelor STL în Netfabb.

Software pentru STL - Netfabb

Volumul 
modelului 
nu este 
calculat din 
cauza 
golurilor din 
obiect.
Sunt afişate 
dimensiunile 
modelului pe 
direcţiile x, y, 
z.



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Semnul exclamării indică faptul că modelul STL conţine erori.
• Se realizează o analiză standard automată a modelului STL.

Software pentru STL - Netfabb
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• Rezultatele analizei arată că suprafaţa este orientată, dar nu 
este închisă.

• Operaţia standard de analiză apare şi meniul Project Tree.
• Alte informaţii disponibile:
- Număr de goluri
- Triunghiuri cu normale inversate
- Muchii incorecte
- Număr de puncte
- Număr de triunghiuri 
- Număr de muchii, etc.

Software pentru STL - Netfabb
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• Zona în care lipsesc triunghiuri este evidenţiată cu galben
atunci când se activează opţiunea Repair (icon cruce roşie).

• Se aplică opţiunea de corectarea automată - Automatic
Repair şi sub-opţiunea Default Repair. Apoi: Apply Repair şi
Remove Old parts.

Software pentru STL - Netfabb
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• Rezultatul operaţiei de corectare este prezentat mai jos. O
nouă analiză standard arată că nu mai există erori.

• Apoi modelul poate fi salvat şi utilizat pentru printare 3D:
Project → Save, Project → Save As sau Export Part → STL.

Software pentru STL - Netfabb
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• Un model de suport de prindere este utilizat pentru a ilustra
operaţiile de corectare manuală a modelelor STL în Netfabb.

Software pentru STL - Netfabb
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• Figura de mai jos prezintă modelul STL după aplicarea
corectării automate, Automatic Repair. Modelul încă are erori.

• Operaţiile manuale de corectare pot fi utilizate pentru
ştergerea triunghiurilor. Triunghiurile sunt selectate (opţiunea
Select triangle) şi apoi şterse (tasta Delete).

Software pentru STL - Netfabb
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• Imaginile arată diferiţi paşi din repararea manuală: selectare
triunghiuri, ştergere triunghiuri.

• Se aplică apoi opţiunea de reparare automată, Automatic
Repair.

Software pentru STL - Netfabb
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• Sesiune de lucru (45 minute)
- Descărcaţi un model STL dintr-o arhivă online
- Verificaţi modelul STL utilizând aplicaţia Netfabb
- Dacă modelul STL este corect, exportaţi-l ca STL ASCII
- Deschideţi fişierul STL ASCII utilizând Notepad şi ştergeţi mai

multe triunghiuri, modificaţi coordonatele vârfurilor şi/sau
orientarea normalelor, pentru a obţine un model STL cu erori

- Salvaţi modelul STL astfel modificat
- Deschideţi noul model STL cu erori şi corectaţi-l utilizând

aplicaţia Netfabb.

Software pentru STL - Netfabb
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• MeshLab, www.meshlab.net – soluţie de verificare, editare,
corectare, randare, aplicare de texturi şi conversie a modelelor
cu suprafeţe formate din reţele de triunghiuri, inclusiv a
modelelor STL.

Software pentru STL - Meshlab
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• Formate de fişire de import şi export în MeshLab.

Software pentru STL - Meshlab
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• Interfaţa MeshLab.

Software pentru STL - Meshlab
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• Opţiuni de editare în Meshlab

Software pentru STL - Meshlab

• Opţiuni de corectare în MeshLab
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• Evidenţierea erorilor în modelul STL de suport de mobil.

Software pentru STL - Meshlab
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• Se poate accesa Remeshing, Simplification and Reconstruction, 
din meniul Filters, pentru repararea defectelor din modelul de 
mână.

Software pentru STL - Meshlab
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• Se aplică opţiunea Surface Reconstruction Ball Pivoting
pentru umplerea golurilor din modelul STL.

Software pentru STL - Meshlab
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• Figura de mai jos prezintă rezultatul aplicării opţiunii de
reconstrucţie a suprafeţei Ball Pivoting din Meshlab

Software pentru STL - Meshlab
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• MiniMagics, www.materialise.com/en/software/minimagics
• Se încarcă modelul de suport de mobil în aplicaţia MiniMagics

software sau 3DPrint Cloud, https://cloud.materialise.com/

Software pentru STL – 3DPrintCloud
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• În cazul aplicaţiei MiniMagics, opţiunile de corectare sunt
doar automate şi se accesează tot prin 3DPrintCloud

• Este necesară crearea unui cont de utilizator

Software pentru STL – 3DPrintCloud
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• Se încarcă modelul STL şi se stabileşte unitatea de măsură (mm).
• Se aplică apoi opţiunea de corectare (Repair) a modelului STL.

Software pentru STL – 3DPrintCloud
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• Figura arată rezultatul corectării automate a modelului STL.

Software pentru STL – 3DPrint Cloud
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• Alte opţiuni disponibile în MinigMagics/3DPrintCloud:
- Scalare
- Analiza grosimii pereţilor
- Reducerea numărului de
triunghiuri
- Extragerea parametrilor 
(dimensiuni de gabarit, volum,
aria suprafeţei, număr de 
triunghiuri)

Software pentru STL – 3DPrintCloud
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• Sesiune de lucru (15 minute)
- Utilizând acelaşi model cu erori ca în prima sesiune de lucru,

reparaţi modelul cu MiniMagics/3DPrint Cloud.

Software pentru STL – 3DPrintCloud
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Printarea 3D utilizând servicii 
online
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Scopul şi rezultatele învăţării

Scopul modulului: Să furnizeze informaţii despre cum se accesează 
serviciile sau platformele online de printare 3D 
pentru încărcarea unui model, estimarea 
costurilor printării 3D, plasarea comenzii pentru 
fabricarea obiectului dorit

Număr de ore: 3h

Rezultate învăţare:  Cunoştinţe despre cum se accesează site-urile 
furnizorilor de servicii onlinede printare 3D

 Cunoştinţe despre cum se încarcă un model 
STL pe un site al producătorilor, cum se 
selectează materialul, procedeul de printare 
3D, maşina

 Cunoştinţe despre cum se evaluează costul, 
timpul de livrare şi cum se accesează alte 
informaţii oferite de furnizori
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Conţinutul cursului

• Servicii online pentru printare 3D :
• Formate de fişiere acceptate de furnizorii de servicii

online de printare 3D
• Fluxul de lucru pentru utilizarea serviciilor online pentru

printare 3D
• Printarea 3D utilizând platforme ca: 3DHubs, Sculpteo, 

Shapeways, i.Materialise, Ponoko
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Servicii online de 
printare 3D
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• Exemple de furnizori de servicii online de printare 3D cu 
afişarea automată a costului printării:

Furnizori de servicii online de printare 3D

Furnizor Website Tip de afacere Proces de printare 3D Materiale

3D Hubs www.3dhubs.com B2C, B2B FDM, SLS, Sla, Polyjet, Termoplastice, Răşini, Metale, 
Hârtie

Shapeways www.shapeways.com B2C, B2B SLS, FDM Termoplastice, Metale
Sculpteo www.sculpteo.com B2C, B2B FDM, SL, SLS, SLM, 

CLIP, Polyjet, DMLS
Plastice, Răşini, Metale

i.materialise https://i.materialise.com B2C, B2B DM, SLS, SL, Ceramic 
Jet, DMLS, Polyjet

Termoplastice, Metale, Ceramică, 
Răşini

Ponoko www.ponoko.com B2C, B2B FDM, SLS, Polyjet Termoplastice, Metale
Protolabs www.protolabs.com B2B FDM, SL, SLS, DMLS Termoplastice, Nailon, Metale
StrataSys 

Direct
www.stratasysdirect.com B2B FDM, SLS, Polyjet, 

DMLS, LS
Termoplastice, Metals, Plastice

QuickParts http://www.quickparts.3
dsystems.com/solutions

B2B FDM, SL, SLS, Polyjet, 
DMLS

Termoplastice, Resins, Metale, 
Nailon

BuildParts www.buildparts.com B2C, B2B FDM, Polyjet, SLA, SLS, 
CLIP

Termoplastice, Metale, Răşini

Make XYZ www.makexyz.com/ B2C, B2B FDM, SL Termoplastice, Nailon, Răşini
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• Formate de fişiere acceptate de furnizorii de servicii online de 
printare 3D (exemple):

- 3DHubs: STL, OBJ
- Shapeways: STL, OBJ, X3D, DAE, VRML
- Sculpteo: STL, OBJ, SKP, OFF, PLY, KMZ, 3DS, AC3D, IPT, DAE, 
MD2/MD3, Q3O, COB, DXF, LWO, IGES, STP, VRML, SCAD, ZIP, 
RAR, TGZ, CARPART, CATPRODUCT, CGR, SLDPRT, SLDASM, IGES, 
IGS, SAT, 3DM, 3MF, PRC, U3D, X_T
- i.materialise: STL, OBJ, WRL, SKP, DAE, 3MF, 3DS, IGS, MODEL, 
3DM, FBX, PLY, MAGICS, MGX, X3D, STP, STEP, PRT, MATPART
- Ponoko: STL, DAE, VRML
- Make XYZ: STL, OBJ, ZIP, STEP, STP, IGES, IGS, 3DS, WRL

Furnizori de servicii online de printare 3D
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• Fluxul de lucru pentru utilizarea serviciilor online de printare
3D constă în parcurgerea următorilor paşi:

1. Se accesează pagina web a furnizorului de servicii de printare
3D

2. Se încarcă modelul (utilizând unul dintre formatele de fişiere
acceptate, de obicei STL)

3. Se alege tipul de procedeu de printare 3D şi/sau materialul,
eventual şi orientarea de fabricaţie

4. Se decide dacă se acceptă printarea 3D a modelului după
primirea de la furnizor a informaţiilor despre preţ şi
timpul/condiţiile de livrare

Furnizori de servicii online de printare 3D



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Furnizori de servicii 
online de printare 3D
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• 3D Hubs
• Reuneşte zeci de mii de deţinători de imprimante 3D din toată 

lumea 
• Oferă sugestii legate de materialul de fabricaţie în funcţie de 

preţ, funcţionalitate, calitatea suprafeţei

3DHubs



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Fluxul de lucru în 3D Hubs

3DHubs
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• Un model STL a fost încărcat ca exemplu, iar procedeul SLS şi 
materialul Nailon au fost alese pentru fabricaţie.

3DHubs
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• Platforma furnizează o listă a furnizorilor de servicii de printare
3D (înregistraţi pe 3DHubs). Aceştia pot fi ordonaţi după cât de
aproape sunt de locul în care se află utilizatorul, preţ etc.

• Data de livrare a obiectului printat 3D este, de asemenea,
menţionată (comanda a fost plasată pe 10 aprilie 2017).

3DHubs
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• Recomandări referitoare la material – utilizatorul trebuie să
răspundă unor întrebări legate de material (metal sau plastic),
proprietăţi de material şi precizie.

3DHubs
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continutul informatiei.

2016-1-RO01-KA202-024578

• Shapeways
• Necesită crearea unui cont de utilizator
• Oferă servicii de printare 3D, precum şi o librărie de modele STL.

Shapeways



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Înainte de încărcarea pe site, modelul trebuie verificat să nu
conţină erori.

• După încărcarea modelului sunt disponibile informaţii despre
dimensiunile sale, volum şi aria suprafeţei. Un viewer STL
permite vizualizarea modelului (opţiuni: zoom şi rotire).

Shapeways



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Următorii paşi de parcurs sunt: alegerea unui material pentru 
obiect şi stabilirea unei orientări de fabricaţie.

• Materiale: plastice dure & flexible, metale, oţel, etc.

Shapeways



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Stabilirea orientării de fabricaţie se face cu ajutorul săgeţilor. 
Opţiunea de Zoom este disponibilă.

Shapeways



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Sculpteo
• Necesită crearea unui cont de utilizator

Sculpteo



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Încărcarea şi vizualizarea unui model STL

Sculpteo



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Informaţiile despre preţ şi data de livrare sunt oferite
instantaneu după alegerea materialului şi a procedeului de
printare 3D.

Sculpteo



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Există şi posibilitatea verificării modelului ca rezistenţă sau
grosime de pereţi.

Sculpteo



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Sculpteo poate, de asemenea, să genereze un dosar de printare 
3D care conţine toate informaţiile şi verificările prezentate.

Sculpteo



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• i.Materialise

i.Materialise



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Se încarcă modelul, se alege materialul, culoarea, finisările şi 
cantitatea.

• Preţul este afişat instantaneu.

i.Materialise



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• BuildParts
• Necesită crearea unui cont de utilizator

BuildParts



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Opţiunea True-Quote în BuildParts
• Paşi: încărcare model; alegere procedeu şi material, alegere

orientare de fabricaţie, rezoluţie, finisare şi cantitate.

BuildParts



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Modelul este încărcat şi orientat de către utilizator

BuildParts



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Platforma generează o cotaţie pentru obiectul de printat 3D

BuildParts



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Sesiune de lucru:
- Descărcaţi un fişier STL dintr-o arhivă online
- Alegeţi cel puţin doi furnizori de servicii online de printare 3D şi 

încărcaţi fişierul pe site-urile/platformele acestora
- Alegeţi material şi procedeu de fabricaţie
- Comparaţi preţurile de fabricaţie ale furnizorilor

BuildParts



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Printarea 3D pe imprimante low-
cost cu depunere de filamente 

de material



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Scopul şi rezultatele învăţării

Scopul modulului: - Să ofere informaţii despre stabilirea orientării de
fabricaţie, a parametrilor de proces şi despre
fabricarea unui obiect utilizând o imprimantă 3D
cu cost redus, precum şi informaţii despre mai
multe aplicaţii software pentru imprimante 3D

Număr de ore: 4h

Rezultate învăţare:  Cunoştinţe despre importul modelului STL în
software-ul imprimantei 3D, scalarea şi
poziţionarea obiectului în spaţiul de lucru al
maşinii, stabilirea parametrilor de proces,
secţionarea modelului

 Cunoştinţe despre aplicarea operaţiilor de post-
procesare pentru obiectele printate 3D



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Conţinutul cursului

• Printarea 3D a unui obiect utilizând aplicaţia Z-suite
pentru imprimantele Zortrax 3D

• Printarea 3D a unui obiect utilizând aplicaţia Cura
pentru imprimantele Ultimaker sau RepRap

• Printarea 3D a unui obiect utilizând aplicaţia Slic3r
pentru imprimantele RepRap

• Printarea 3D a unui obiect utilizând aplicaţia ReplicatorG
pentru imprimantele RepRap, Makerbot Replicator, Thing-O-
Matic



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Printarea 3D utilizând
aplicaţia Z-suite



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Aplicaţia Z-Suite pentru imprimantele Zortrax 3D
• Modelaţi un obiect într-un software de modelare 3D sau descărcaţi-l

dintr-o arhivă online ca fişier STL.
• Dacă obiectul este generat într-un software 3D CAD, salvaţi-l ca model

STL.
• Verificaţi şi, dacă este necesar, corectaţi modelul STL utilizând Netfabb.

Printarea 3D utilizând aplicaţia Z-Suite

Obiect – modelat în software 3D CAD

Netfabb -
analiză STL



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Deschideţi un model STL în Z-Suite prin tragere (drag-and-
drop) sau cu icon-ul Add Object.

• Butoanele mouse-ului pot fi utilizate pentru manipularea
obiectului (buton 1-rotire, scroll-zoom, buton 2-pan).

Printarea 3D utilizând aplicaţia Z-Suite



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Orientarea modelului în spaţiul de lucru al imprimantei 3D
trebuie să fie realizată astfel încât să fie satisfăcute anumite
criterii stabilite de utilizator, de exemplu: reducerea
structurii suport, amplasarea suprafeţelor importante pe
verticală sau orizontală, amplasarea găurilor astfel încât
axele lor să fie de-a lungul direcţiei de fabricaţie etc.

• Rotirea poate fi realizată în jurul axelor x, y şi z.

• Obiectul este selectat prin plasarea mouse-ului pe una
dintre suprafeţe şi făcând click cu butonul 3 al mouse-ului.

Printarea 3D utilizând aplicaţia Z-Suite



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Orientarea modelului în spaţiul de lucru al maşinii.

Printarea 3D utilizând aplicaţia Z-Suite

Obiect rotit cu 270 grade în jurul axei y
Orientarea 1

Orientarea 2



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• De asemenea, obiectul poate fi deplasat pe platforma de
fabricaţie utilizând butonul Move.

• Obiectul poate fi scalat utilizând butonul Resize cu valorile
dorite de-a lungul direcţiilor x, y şi z.

Printarea 3D utilizând aplicaţia Z-Suite



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Obiectele pot fi tăiate cu opţiunea Split. De exemplu, în
figura de mai jos obiectul este tăiat cu planul zx.

Printarea 3D utilizând aplicaţia Z-Suite

- Fiecare obiect rezultat din aplicarea opţiunii Split poate fi exportat separat.



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Stabilirea parametrilor de proces: material, grosime strat, grad 
de umplere a stratului (infill), număr de straturi depuse la baza 
piesei, număr de straturi depuse la partea de sus a piesei viteză 
de depunere etc. 

Printarea 3D utilizând aplicaţia Z-Suite



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Pentru fiecare material sunt disponibile anumite valori ale
grosimii stratului.

• Accesarea opţiunii de pregătire pentru printare 3D (Prepare to
print) determină începerea secţionării obiectului pe baza setărilor
parametrilor de proces. Sunt generate traiectoriile capului de
extrudare pentru depunerea materialului pentru obiect şi pentru
structura sa suport. În Z-Suite, materialul pentru model este afişat
cu albastru, iar material pentru suport cu gri. Fiecare strat de
material poate fi vizualizat în Z-Suite utilizând opţiunea Pause din
Tools.

• Informaţii despre timpul
de fabricaţie (estimativ) şi
consumul de filament (în
metri şi grame).

Printarea 3D utilizând aplicaţia Z-Suite



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Printarea 3D utilizând aplicaţia Z-Suite

Estimarea timpului de fabricaţie şi a 
consumului de material

Structură 
suport pentru 
bază

Obiect

Structură 
suport

Vizualizare 
strat cu strat

• Vizualizare strat cu strat



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Printarea 3D utilizând
aplicaţia Cura



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Aplicaţia Cura pentru imprimantele 3D Ultimaker sau Reprap
• Se deschide un model STL. Implicit acesta este amplasat în

mijlocul platformei de fabricaţie. El este secţionat imediat
după import, informaţiile despre timpul de fabricaţie şi
consumul de filament fiind afişate.

Printarea 3D utilizând aplicaţia Cura



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Obiectele pot fi deplasate pe platformă utilizând primul
buton al mouse-ului, pot fi rotite cu al doilea buton al
mouse-ului şi mărite/micşorate (zoom) cu rotiţa de defilare.

Printarea 3D utilizând aplicaţia Cura



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Vizualizarea straturilor.

Printarea 3D utilizând aplicaţia Cura



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Diferite setări ale parametrilor de proces

Printarea 3D utilizând aplicaţia Cura



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Setări uzuale pentru imprimata 3D

Printarea 3D utilizând aplicaţia Cura



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Exemplu de fişier Gcode

Printarea 3D utilizând aplicaţia Cura



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Printarea 3D utilizând
aplicaţia Slic3r



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Aplicaţia Slic3r pentru imprimantele RepRap 3D
• Deschiderea modelului STL cu opţiunea Add
• Manipularea obiectului: rotire (buton 1), mărire/micşorare şi 

pan (rotiţa de defilare), pan (butonul 2)

Printarea 3D utilizând aplicaţia Slic3r



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Scalarea obiectului în Slic3r

Printarea 3D utilizând aplicaţia Slic3r

• Tăierea obiectului în
Slic3r



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Setări printare 3D        Setări filament          Setări imprimantă 3D  

Printarea 3D utilizând aplicaţia Slic3r



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Setări ale umplerii stratului: densitate, model umplere,
model de umplere strat bază/top.

Printarea 3D utilizând aplicaţia Slic3r



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Setări ale diametrului filamentului, uzual 1.75 mm sau 3 mm.

• Setări ale formei şi dimensiunii platformei.

Printarea 3D utilizând aplicaţia Slic3r



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Vizualizarea straturilor

Printarea 3D utilizând aplicaţia Slic3r

Alegerea unui strat



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Vizualizarea straturilor

Printarea 3D utilizând aplicaţia Slic3r



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Mai multe opţiuni sunt disponibile în modul Expert care
poate fi accesat din meniul File.

Printarea 3D utilizând aplicaţia Slic3r



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Setări pentru viteză Setări avansate

Printarea 3D utilizând aplicaţia Slic3r



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Printarea 3D utilizând
aplicaţia ReplicatorG



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Aplicaţia ReplicatorG pentru imprimantele RepRap 3D 
printers, Makerbot Replicator, Thing-O-Matic

• Aplicaţia trebuie rulată ca Administrator şi necesită Python
• Deschiderea unui model STL seface cu opţiunea Open din File

Printarea 3D utilizând ReplicatorG

Vizualizarea
obiectului



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Obiectele pot deplasate, rotite, oglindite (obiectul este
orientat în oglindă faţă de x, y sau z) sau scalate.

Deplasare obiect                     Rotire Scalare

Printarea 3D utilizând ReplicatorG



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Accesarea opţiunii de estimare a timpului de printare: 3h 1min

Printarea 3D utilizând ReplicatorG



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Tabloul de control al imprimantei 3D

Printarea 3D utilizând ReplicatorG



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
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• Lista driverelor de imprimante 3D disponibilă în ReplicatorG

Printarea 3D utilizând ReplicatorG
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• Generarea traseelor capului de extrudare se face cu Gcode-
>Generate;  În Preferences se stabileşte calea către Python

• Necesită Skeinforge sau un alt software de secţionare (cum 
ar fi Slic3r). 

Printarea 3D utilizând ReplicatorG
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• Rezultatele secţionării obiectului

Printarea 3D utilizând ReplicatorG
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• Exemplu de Gcode generat de aplicaţia Replicator G

Printarea 3D utilizând ReplicatorG
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3DP și antreprenoriat
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Scop și obiective învățare

Scopul modulului: Să inspire și să ajute tinerii sa demareze o 
afacere bazată pe imprimarea 3D

Număr ore: 3 ore

Rezultatele învățării: • Cunoștințe despre oportunitățile din 
imprimare 3D în antreprenoriat

• Conștientizarea cerințelor într-o afacere 
bazată pe imprimare 3D
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Cuprins

• Exemple de afaceri 3D și start-ups 
• Surse de finanțare
• Competențe solicitate pentru o afacere cu imprimare 

3D
• Oportunități pentru liber profesioniști
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Exemple de afaceri 3D și 
start-ups 
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Imprimarea 3D oferă mari oportunități pentru investiții, 
având din ce în ce mai mulți antreprenori și potențiali 
clienți interesați de posibilitățile pe care aceasta le oferă. 

Afaceri 3D si start-ups 
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Servicii de imprimare 3D

Companii care imprimă 
obiecte pentru tine
Exemple: 

• Shapeways
• 3D Hubs
• i.materialise
• Sculpteo
• iMakr
• MakeXYZ
• Ponoko
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Repozitorii 3DP

Platforme care oferă 
modele pentru 
imprimare 3D
Exemple: 

• Thingiverse
• GrabCAD
• Sketchfab
• YouMagine
• Cults3D
• Zortrax Library
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Huburi imprimare 3DP 

Rețele de 
imprimante 3D.
Exemple: 

• 3DHubs
• MakeXYZ
• Fiverr
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Alte idei de afaceri 3DP 

- Furnizare training 3DP 
- Producția de imprimante 

3D
- Servicii de prototipare
- Modă imprimată 3D
- Piese și produse imprimate 

3D
- Alimente imprimate 3D 
- Crearea modelelor 3DP 
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• Design și producție imprimante 3D
• Procurarea și imprimarea 3D a componentelor necesare, 

asamblare, calibrare și comercializare imprimante 3D 

Producția de imprimante 3D

Exemple:
• Makerbot, Formlabs (SUA)
• BQ, BCN3D (Spania)
• WASP, Roboze, Sharebot (Italia)
• Zortrax, Sinterit (Polonia)
• Symme3D, Build3DParts (România)
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O mare varietate de 
modele pot fi create 
prin imprimare 3D.                 

Obiecte personalizate
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Prototipuri

Prototiparea este una dintre cele mai importante aplicații 
ale imprimării 3D.
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Modă imprimată 3D – genți

Odo Fioravanti – Clutch Berna

Poșeta Berna Clutch de la Odo Fioravanti, lansată în 2017 la Paris, are 
forme curbe și este inspirată de structura urbană unică a orașului 
Berna. Este o ediție limitată și realizarea ei prin intermediul imprimării 
3D a fost o soluție eficientă din punctul de vedere al costurilor. 
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Bijuterii imprimate 3D 

Există numeroase exemple în domeniul bijuteriilor.

Omri Revesz a creat 
colecția Penrose.
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Se bazează pe modul în care 
modelele și formele apar în 
natură și creează structuri 
matematice care permit 
obținerea unor obiecte mai 
complicate, unice și 
personalizate cu ajutorul 
imprimării 3D.

Bijuterii imprimate 3D 

Nervous System

Nervous System, o altă afacere de succes, creează 
bijuterii inspirate de stiință și tehnologie.
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Danit Peleg a realizat o întreagă colecție folosind 
imprimanta 3D de acasă.

Haine imprimate 3D
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Prototipuri și piese pentru ceasuri

ZGOD Watches. ZegarkiFossil watches 

ZGOD. Zegarki, o afacere poloneză, creează ceasuri cu carcase 
imprimate 3D.
Fossil folosește imprimare 3D pentru prototipuri. Designul poate fi 
ajustat oricând și reprintat 3D, astfel producerea prototipului 
devine mai ieftină și durează mai puțin. 



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Nenumărate modele pot fi realizate prin imprimare 3D.

Jucării imprimate 3D
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Aplicațiile imprimării 3D în scopuri medicale includ 
protezele și părti ale corpului.

Dispozitive medicale imprimate 3D
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Obiecte personalizate imprimate 3D
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Mai multe tipuri de alimente pot fi realizate prin 
imprimare 3D în design-uri îndrăznețe.

Alimente imprimate 3D 
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Surse de finanțare
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Surse:
1. Investiții personale
2. Capital privat
3. Incubatoare și acceleratoare de afaceri
4. Împrumuturi bancare
5. Angel Investors 
6. Fonduri nerambursabile
7. Crowdfunding

Oportunități de finanțare
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Crowdfunding
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Competențe necesare 
pentru afaceri în 3DP
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În funcție de idea de afaceri, unele competențe specifice ar 
putea reprezenta un atu în fucționarea cu succes a afacerii.
Aceste competențe pot fi dobândite în cadrul cursului 3DP.

Competențe necesare
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Creativitate – Generarea unor noi concepte
Desen – reprezentarea obiectelor pe hârtie

Competențe de design
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• Cunoaștere a nevoilor clienților
• Analiza pieței

Competențe de marketing
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• Matematică, stiinte, fizică, chimie, mecanică

Competențe tehnice și de inginerie
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Competențe IT 
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Oportunități pentru 
liber-profesioniști
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• Cererea pentru liber-profesioniști în imprimare 3D este 
în creștere

• Majoritatea joburilor care solicită expertiză în 
imprimare 3D:
• Ingineri industriali și mecanici
• Software developers
• Designers
• Marketing managers

Oportunități pentru liber-profesioniști
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• Upwork
• Guru.com
• CAD crowd
• peopleperhour
• Freelancer
• xplace

Site-uri Freelancing
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Useful Topic Related Links
• Upwork.com
• Guru.com
• CAD Crowd
• 3D Printing Job Board
• The MediaBistro
• https://www.symme3d.com/
• https://www.kickstarter.com/
• www.indiegogo.com
• https://3dprinting.com/3d-printing-

service/
• 10 Amazing 3D Printing Startups
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Design pentru imprimarea 3D 
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Scopul și rezultatele învățării

Scopul modulului: Să ofere informații despre defectele des 
întâlnite la piesele imprimate 3D și despre 
regulile de design pentru imprimarea 3D a 
pieselor și ansamblelor, în vederea reducerii 
incidenței acestor defecte. 

Număr de ore: 3 ore

Rezultate învățare: • Cunoștințe despre defectele pieselor 
imprimate 3D cu tehnologia FDM

• Înțelegerea influenței orientării de fabricație 
asupra calității și proprietăților mecanice ale 
piesei.

• Cunoștințe despre regulile de design pentru 
imprimarea 3D a pieselor și ansamblelor
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Conținutul cursului

• Tipuri de defecte la piesele 
imprimate 3D prin FDM

• Rolul orientării de fabricație 
în imprimarea 3D 

• Reguli de design pentru 
imprimarea 3D a pieselor și 
ansamblelor
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Fused Deposition Modelling (FDM) va fi considerată ca tehnologie 
de imprimare 3D în studiu de caz pentru defecte.

Prioritățile cursului

Altele...
De ex. Laminated 
Object Manufacturing 
(LOM):

Materie primă:

hârtie

Tehnologie de imprimare 3D

Fused Deposition 
Modelling (FDM)

Materie primă: 
filament din polimeri

Stereo Lithography 
(SL)

Materie primă: 
Rășină lichidă 
fotosensibilă

Selective Laser 
Sintering (SLS)

Materie primă:

Pulbere (inclusiv
polimeri, ceramică, 
metal)

Prioritatea cursului
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Tipuri de defecte la piesele 
imprimate 3D prin FDM



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

• Cauzele defectelor sunt clasificate în funcție de etapa în care 
acestea apar

• Clasificarea se aplică imprimării 3D în general, nu numai FDM

Defecte ale pieselor imprimate 3D FDM

Modelare
3D CAD

Pregătirea 
fișierelor STL 

Erori procesare date Defecte de fabricație

Procesul de 
imprimare 3D

Defecte post-
procesare
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• Erori legate de pregătirea datelor, cauzate de:
1. Generarea fișierelor STL: erori inerente datorate 

discretizării modelului 3D CAD. Rezoluția fișierelor STL
poate fi setată în timpul  generării lor în programul CAD.

Erori procesare date

Rezoluție medie a 
fișierelor STL

Rezoluție mică a 
fișierelor STL
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2. Lipsa unor structuri suport: software-ul le poate omite, 
în mod eronat, lucru care poate duce la defecte în 
timpul procesului de fabricare.

Erori procesare date

Defecte cauzate de 
lipsa unei structuri 

de suport 
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• Defectele legate de procesul FDM includ:
1. Goluri între umplere și contur: umplerea are un model 

diferit față de conturul piesei

Defecte legate de procesul FDM

Umplere
Conturul piesei
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Urme

2. Urme: pot să apară pe suprafața piesei din cauza mișcării 
de du-te-vino a extrudorului în planul XY.

Defecte legate de procesul FDM
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Efectul de scară

3. Efectul de scară: din cauza secționării modelelor CAD 3D 
în straturi

Defecte legate de procesul FDM
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4. Calibrarea greșită a imprimantei 3D: poate duce la 
rezultate dezastruoase.

Defecte legate de procesul FDM
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5. Structura de suport nu se dezlipește 
de piesă: uneori structura de suport se 
dezlipește foarte greu, probabil din 
cauza setărilor greșite de temperatură.

6. Deformări: piesa se deformează din 
varii motive: orientarea de fabricație 
incorectă, uzura suprafeței de 
imprimare etc.

Defecte legate de procesul FDM

Structura de suport aderă la piesă
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• Aceste categorii de defecte includ:
1. Material de suport neîndepărtat: pot exista anumite părți 

interne (de ex. acoperișul clădirii prototip de mai jos) care 
fac dificilă detașarea materialului de suport.

Defecte de post-procesare

Material de suport 
înțepenit
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Rolul orientării de fabricație 
în imprimarea 3D
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• Orientarea pieselor are un rol esențial în FDM, mai ales pentru:
1. Rezistența piesei (piesele FDM au rezistență mai mică pe 

direcția verticală)
2. Tipul și cantitatea de material de suport
3. Timpul necesar pentru finisarea piesei

Rolul orientării de fabricație

Material de suport Material piesă
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Cum afectează 
orientarea de 
fabricație FDM  
o piesă 
imprimată 3D ?

Efectele orientării de fabricație

https://www.youtube.com/watch?v=oyukaFkI_GQ
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Reguli de design pentru imprimarea 
3D a pieselor și ansamblelor
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• Aceste reguli au fost clasificate pentru a reflecta cele 3 etape 
principale ale ciclului de imprimare 3D:

Design pentru piesele imprimate 3D FDM

Modelarea 3D 
CAD

Pregătirea 
fișierelor STL

Reguli de design pentru pregătirea 
datelor

Reguli de design pentru 
fabricare

Procesul de 
printare 3D

Reguli de design 
post-procesare
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1. Aplicare caracteristici formă 
(decupaje, întărituri, canale, găuri) 
pt. îmbunătățirea proprietăților 
mecanice ale piesei, reducerea 
timpului de fabricație și a costului 
materialelor.

2. Pentru găurile mici trebuie 
verificat cel mai mic diametru al 
filamentului extrudat, acesta 
dictând dimensiunea minimă ce 
poate fi obținută. 

Design pentru pregătirea datelor

Adăugarea unui decupaj -
mai puțin material
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3. In cazul ansamblelor, trebuie luat 
în considerare un joc suficient de 
mare între piesele îmbinate (de 
ex. 0.5mm)

Atenție - aceasta poate varia de la o 
imprimantă FDM la alta – trebuie 
verificate specificațiile tehnice pentru 
imprimanta 3D folosită.

Design pentru pregătirea datelor
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4. Aplicare de găuri, decupaje etc. 
pentru inserarea altor componente, 
cum sunt etichete RFID, circuite 
electronice, inserții metalice filetate, 
în timpul procesului de imprimare. 
(în majoritatea cazurilor, imprimarea 
poate fi pusă pe pauză.) 

5. Colțurile ascuțite trebuie evitate, pe 
cât posibil, deoarece sunt 
concentratori de tensiune pentru 
obiectele printate FDM.

Design pentru pregătirea datelor

Colțuri rotunjite pentru a 
elimina concentrarea 

tensiunilor
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Procedura de 
inserare a 
elementelor 
metalice în 
piesele FDM

Inserare părți metalice in piesele FDM

https://www.youtube.com/watch?v=A_BcU7ipHew
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5. Este recomandabilă setarea 
grosimii minime de perete în 
funcție de grosimea stratului.

Dacă grosimea minimă de perete a  
piesei (T) este 0.3mm, atunci 
grosimea stratului (t) este 0.1mm; 
daca T = 0.75mm,  t = 0.25mm. 
Astfel, se minimizează efectul de 
scară.

Design pentru pregătirea datelor
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1. Selectarea materialului are un rol 
fundamental în determinarea 
proprietăților piesei, inclusiv cele 
mecanice, termice, chimice și 
electrice.

2. Materialul influențează grosimea 
stratului, de unde rezultă o 
influență directă asupra calității 
suprafeței (de ex., grosimea min. 
pt. ABS este cca. 0.13mm, în timp 
ce pentru PC este de cca. 0.18mm)

Design pentru fabricarea FDM

Cartuș ABS folosit in FDM
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3. Gradul de umplere a stratului (infill) trebuie selectat în funcție 
de destinația piesei.

Acest parametru are un efect direct asupra proprietăților 
mecanice ale piesei, consumului de material și timpului de 
fabricare.

Design pentru fabricarea FDM
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4. Trebuie verificat că unitățile de măsură ale modelului STL sunt 
aceleași cu cele din software-ul imprimantei 3D.

Design pentru fabricarea FDM
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5. Pentru a crește calitatea suprafețelor și precizia, trebuie 
selectată cea mai mică rezoluție a stratului.

Design pentru fabricarea FDM
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Rezultatele 
obținute la 
imprimarea 
FDM cu diferite 
viteze. 
Material: PLA.

Efectul vitezei de imprimare

https://www.youtube.com/watch?v=BBQTD9_34sQ
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1. Prevederea de găuri pentru 
drenarea materialului de 
suport solubil în timpul post-
procesării.

2. Cu cat sunt mai multe structuri 
de suport, cu atât calitatea 
suprafeței va fi mai scăzută. 
Trebuie reduse structurile de 
suport când se pregătesc 
fișierele pentru imprimarea 3D.

Design pentru post-procesarea FDM

Model de mumie egipteană cu materialul de 
suport prins în bărbie 
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Useful Topic Related Links

Dedicated CAD package on Design for 3DP

FDM for End-Use Parts:
Tips and Techniques for Optimization

Inserting Metal Inserts Into 3D Printed Parts
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Studii de caz pentru stimularea
spiritului antreprenorial, creativității 

și inovării
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Scop și rezultatele învățării

Scopul modulului: Furnizarea de  cunoștințe de bază în domeniul 
afacerilor bazate pe  imprimarea  3D 

Număr de ore: 2 ore

Rezultate învățare: • Înţelegerea impactului tehnologiei de 
imprimare 3D în diverse afaceri

• Dobândirea cunoștințelor necesare pentru 
lansarea și consolidarea de afaceri în 
domeniul imprimării 3D
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Cuprins curs

• Imprimarea 3D - studii de caz în architectură și artă
• Studii de caz în imprimarea 3D pentru domeniul 

medical
• Tehnologia imprimării 3D ca suport pentru inovare și 

creativitate
• Imprimarea 3D - studii de caz pentru formare și 

educație
• Imprimarea 3D - studii de caz în inginerie și industrie
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Imprimarea 3D - studii de 
caz în architectură și artă
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Imprimarea 3D - soluții revoluționare și inovatoare pentru
companiile de arhitectură, pentru muzee, clădiri de patrimoniu
național și, de asemenea, pentru clienții obișnuiți.

Imprimarea 3D în arhitectură și artă
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Beneficii:
• creșterea productivității: orice 
design complicat devine tangibil 
foarte rapid; 
• folosirea mai multor culori și  
materiale diferite (inclusiv 
reciclabile);
• flexibil la cerințele clientului;
• re-editare, re-utilizare, re-
imprimare, partajare. 

Imprimarea 3D în arhitectură și artă



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Studii de caz în imprimarea
3D pentru domeniul medical
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Bio-imprimare 3D – timpurile în care 
mașinile pe care le-am conceput 
construiesc organe și alte părți din 
noi. 
• Tehnologie: topirea sau 
depozitarea materialelor cum ar fi 
plasticul, metalul, ceramica, 
pulberile, lichidele, în straturi;
• Vizualizare: ajută la pregătirea și 
planificarea unor operații 
chirurgicale complexe.  

Imprimarea 3D în domeniul medical
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Proteze pentru înlocuirea genunchilor,
a mâinilor sau picioarelor amputate,
suporturi de sprijin pentru fracturi,
ochi, nas pentru pacienții cu mutilare
facială etc.
• funcțional, versatil, ușor de 
personalizat;
• realizare într-o zi;
• prețuri accesibile.

Imprimarea 3D în domeniul medical
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Proteze - brațe și picioare robotizate 
imprimate 3D
• numai în Statele Unite ale Americii, 
aproape 200.000 de amputări sunt 
efectuate în fiecare an;
• imprimare mai ușoară și mai rapidă;
• asamblare ușoară și rapidă;
• preț scăzut al protezelor imprimate 3D 
față de tehnologiile clasice.

Imprimarea 3D în domeniul medical
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Proteze oculare
• o imprimantă 3D poate produce 150 
proteze oculare/oră și reduce costurile cu 
97% față de versiunile realizate manual 
existente.
Protezarea urechii externe
• sute de mii de oameni au suferit leziuni 
ale urechilor din cauza rănilor provocate 
de gloanțe, cancer al urechii sau 
malformații ale urechii externe;
• oamenii de știință creează urechi noi cu 
ajutorul imprimării 3D și a celulelor stem 
umane.

Imprimarea 3D în domeniul medical
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Bio-imprimarea 3D de țesuturi și organe
• o mașină de imprimat bio este capabilă de a imprima țesuturi 
umane;
• piele 3D imprimată pentru persoanele arse;
• provocarea: menținerea țesuturilor mai mari în viață, găsirea de 
materiale pentru imprimare bio 3D.
• inima printată 3D ajută la dezvoltarea cateterului multidirecțional 
Sigma, ce poate salva multe vieți.

Imprimarea 3D în domeniul medical
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Imprimarea 3D Dental - Dinți, 
implanturi, danturi și coroane 
dentare;
• personalizat, model exact;
• realizare rapidă;
• proces curat - mult mai puțin 
murdar decât metoda cu ipsos;
• diverse materiale;
• preț accesibil;
• ușor de stocat în formate digitale. 

Imprimarea 3D în domeniul medical
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Imprimarea 3D în chirurgia 
maxilo-facială și orală -
implanturi dentare și coroane;
• ajută dentistul să pună 
diagnosticul și să decidă cu 
privire la tratament;
• creează modele și ghiduri de 
foraj chirurgicale pentru defecte 
congenitale, leziuni sau 
îndepărtare de masă osoasă;
• durata procesului: aprox. o oră.

Imprimante 3D în Medicină și Sănătate
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Tehnologia 3DP ca support 
pentru inovare și creativitate
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Tipărește propriul membru bionic 
• permite oricui din lume să descarce și să imprime 3D 
propriile membre bionice; 
• proiectul de afaceri - Mâinile bionice low-cost care arată și 
se simt bine - a câștigat finala Intel “Make it wearable” 
Challenge (250.000 $).

Imprimare 3D-Creativitate și inovație
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Sistemul energetic integrat
• tehnologii energetice curate într-o clădire și un vehicul imprimate 
3D;
• conectați un vehicul electric hibrid, alimentat cu gaz natural, cu o 
clădire alimentată cu energie solară pentru a crea un sistem energetic 
integrat.

Imprimare 3D - Creativitate și inovație
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Imprimarea 3D - studii de caz
pentru formare și educație
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Revoluționează sala de clasă
• stimulează creativitatea și inovarea;
• încurajează potențialul artistic; 
• creează  cetățeni responsabili digital;
• încurajează munca manuală; 
• promovează munca în echipă; 
• rezolvă probleme din lumea reală.

Imprimarea 3D în pregătire și educație
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Revoluționează sala de 
clasă
• Chimie - modele de 
structuri și substanțe 
moleculare complexe

• Biologie - studiul secțiunii 
transversale a diferitelor 
organe, structuri osoase.

Imprimarea 3D în formare și educație
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Revoluționează sala de clasă
• Proiectare și Inginerie -
elevii pot imprima propriile 
lor prototipuri: automobile, 
piese de motor etc.

Imprimarea 3D în formare și educație



Material realizat cu sprijinul financiar al Comisiei Europene. Continutul prezentului material reprezinta responsabilitatea 
exclusiva a autorilor, iar Agentia Nationala si Comisia Europeana nu sunt responsabile pentru modul în care va fi folosit 
continutul informatiei.

2016-1-RO01-KA202-024578

Revoluționează sala de clasă
• Istorie - elevii pot imprima 
artefacte și clădiri istorice 
pentru examinare;

Imprimarea 3D în formare și educație
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Revoluționează sala de clasă
• Jocuri - elevii pot imprima elemente ale unor jocuri vechi sau pot 
inventa jocuri noi;
• Instrumente muzicale - design nou pentru instrumente obișnuite sau 
crearea unora noi.

Imprimarea 3D în formare și educație
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Imprimarea 3D - studii de 
caz în inginerie și industrie
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Revoluționează industria de 
automobile
• Proiectarea motorului - modele noi
• Imprimarea 3D este cea mai eficientă 
și economică metodă aflată la dispoziția 
designerilor pentru modificarea 
proiectelor. 

Imprimarea 3D în inginerie și industrie
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Schimbarea industriei
• producătorii folosesc imprimarea 
3D pentru fabricarea elicelor
• revoluționează modul în care 
sunt create prototipurile și 
modelele

Imprimarea 3D în inginerie și industrie
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Fabricarea produselor industriale
• Oportunitate pentru companiile 
mai mici, permițându-le să 
concureze cu companiile mai mari 
și să ofere consumatorilor 
posibilitatea de a alege 
• piață de reparații și întreținere

Imprimarea 3D în inginerie și industrie
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Fabricarea roduselor industriale
• producție mai ieftină și mai 
eficientă pentru industria auto, 
medicală și aerospațială.

Imprimarea 3D în inginerie și industrie
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Useful Topic Related Links

•Imprimanta 3D – o revoluție în Arhitectură și 
Design - https://www.youtube.com/watch?v=cOaqRkLP4lI

• Sagrada Familia, modelul pentru imprimare 3D 
https://www.youtube.com/watch?v=UJ8NcKNlZzg

•casa imprimată 3D
http://apis-cor.com/en/about/news/first-house

• Imprimarea 3D pentru arhitecti: 
http://my3dconcepts.com/3dp-for-architects-lm/
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Useful Topic Related Links

• Bio-imprimare 3D 
https://www.youtube.com/watch?v=s3CiJ26YS_U

• Imprimare 3D căști personalizate: 
https://www.youtube.com/watch?v=5YB8BjOn6B0
• https://www.youtube.com/watch?v=XvcpC424HAI

•Proteză braț: 
https://www.youtube.com/watch?v=JDL16rmwgHw

• Imprimarea 3D în Educație
https://www.youtube.com/watch?v=X5AZzOw7FwA
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Viitorul tehnologiilor de 
imprimare 3D
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Scop și obiective învățare

Scopul modulului: Să prezinte o vedere de ansamblu asupra 
viitorului tehnologiilor de imprimare 3D

Număr ore: 2 ore

Rezultatele învățării: • Înțelegerea riscurilor și reglementărilor 
potențiale legate de imprimarea 3D 

• Cunoștințe despre trenduri și direcții de 
dezvoltare în imprimarea 3D
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Schema de prezentare

• Mit și realitate în imprimarea 3D
• Riscuri și reglementări în imprimarea 3D
• Trenduri și direcții de dezvoltare în imprimarea 3D
• Exemple
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Mit și realitate în 
imprimarea 3D
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Miturile provoacă un amestec de entuziasm și dezamăgire în 
privința imprimării 3D, putând duce la încetinirea dezvoltării și 
adoptării pe scară largă a acesteia.

Mit și realitate în imprimarea 3D

Mit Realitate
Imprimantele 3D sunt
prea scumpe

Prețurile variază într-o gamă foarte 
largă și încep de la aproximativ 100 
de dolari.

Imprimarea 3D este doar 
pentru plastic

Există foarte multe tipuri de 
materiale care pot fi imprimate 3D: 
metal, lemn, rășină, fibre carbon, 
bio-materiale, alimente, beton etc.
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Mit și realitate în imprimarea 3D

Mit Realitate
Imprimantele 3D pot 
produce organe umane.

În prezent, nu este posibilă
imprimarea 3D a organelor.

Obiectele se fabrică mai 
repede prin imprimare 
3D.

Imprimarea 3D este mai lentă 
decât metodele convenționale de 
producție.

În fiecare casă va exista, în 
curând, o imprimantă 3D.

Sunt prea puține aplicații pentru a 
justifica efortul și costurile legate 
de achiziționarea și operarea unei 
imprimante 3D de către o 
persoană obișnuită.
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Mit și realitate în imprimarea 3D

Mit Realitate
Unele obiecte costă 
mai puțin dacă sunt 
produse prin 
imprimare 3D.

Costurile prototipării pot fi reduse cu 
ajutorul imprimării 3D, dar produsele 
fabricate în serie costă mai mult în 
cazul imprimării 3D decât în cazul 
metodelor convenționale.

Imprimarea 3D este 
pentru producția de 
serie.

Imprimarea 3D este convenabilă 
pentru obiecte personalizate sau, 
posibil, în cazul fabricării obiectelor cu 
formă foarte complexă, în serie mică.
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Riscuri și reglementări în 
imprimarea 3D
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Imprimarea 3D permite copierea și replicarea ușoară a designului și 
a produselor.

Riscuri – proprietăți intelectuale
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Proiectele produselor 3D sunt fișiere software care pot fi:
• Furate și utilizate pentru imprimarea 3D a produselor
• Manipulate de către hackeri

Riscuri cibernetice
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Imprimarea 3D estompează granițele dintre diversele poziții de pe 
lanțul de producție.

Riscuri– răspunderi

Cine este responsabil pentru 
daunele cauzate de un obiect 
imprimat 3D? Cel ce a creat 
fișierul? Furnizorul imprimantei 
3D? Cel ce a imprimat obiectul?

Este necesară crearea unui cadru legal clar.
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Imprimarea 3D simplifică producerea de 
obiecte contrafăcute.
Există mari preocupări, mai ales în sectoare 
sensibile – aerospațial, medical etc.

Riscuri – obiecte contrafăcute
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Reglementările sunt necesare mai ales pentru a controla obiecele 
imprimate 3D pentru utilizări potențial infracționale – arme, chei, 
manipulări bancomate etc.

Reglementări în imprimarea 3D
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Trenduri și direcții de 
dezvoltare în imprimarea 3D
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• Imprimare 3D multi-material 
• Imprimare 3D multi-coloră
• Imprimante mai rapide, mai bune, mai mari și mai ușor de folosit
• Modelare 3D mai ușoară
• Noi aplicații pentru imprimare 3D
• Înbunătățiri ale imprimării 3D cu metal
• Clădiri imprimate 3D
• Noi materiale pentru imprimare 3D

Trenduri și direcții de dezvoltare
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Exemple
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Imprimare 3D multi-material/multi-color

Aplicații: prototipuri și
modele foarte realiste; 
suporți dizolvabili

Materiale disponibile: rășini, 
filament dizolvabil
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Imprimare 3D cu metal

Aplicații: prototipuri, piese 
funcționale, bijuterii, 
implanturi medicale etc.

Materiale disponibile: 
aluminiu, oțel, bronz, cupru, 
argint, aur, platină, titan
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Clădiri imprimate 3D

Aplicații: case, apartamente, 
clădiri de birouri, structuri pe 
planeta Marte sau pe Lună

Materiale: beton, plastic, 
rășini, pământ etc.
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Printuri 3D de dimensiune mare


